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B 

Wprowadzenie 

do ćwiczenia 

1. Cel i przebieg ćwiczenia 

Celem ćwiczenia jest poznanie działania tranzystora IGBT od strony właściwości dynamicznych, 
a więc związanych z przełączaniem przyrządu między stanami załączenia (nasycenia) i wyłączenia 
(blokowania). Tranzystor będzie analizowany w najprostszej do analizy konfiguracji pracy – 
łącznika dolnego z obciążeniem rezystancyjnym. Wybrany przyrząd należy do serii standardowej, 
nieoptymalizowanej pod szczególnym kątem. Umożliwi to obserwację wszelkich specyficznych 
właściwości dynamicznych tranzystora IGBT. Określony zostanie również wpływ parametrów 
obwodu bramki na parametry dynamiczne tranzystora. 





 

© 2017 Łukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki Łódzkiej 

2. Tranzystor bipolarny z izolowaną bramką – IGBT 

2.1. Wprowadzenie 

2.1.a. Geneza i budowa 

Tranzystor IGBT (ang. Insulated Gate Bipolar Transistor ‛tranzystor bipolarny z izolowaną 
bramką’) został wprowadzony na rynek w późnych latach osiemdziesiątych w odpowiedzi na 
zapotrzebowanie przemysłu na przyrząd sterowany napięciowo-ładunkowo zachowujący 
wszystkie zalety tranzystora MOSFET typu VDMOS, lecz charakteryzujący się znacznie 
mniejszą rezystancją w stanie załączenia przy nie zmienionej zdolności blokowania 
napięcia. Chodziło o przyrząd wysokonapięciowy umożliwiający przewodzenie dużo większych 
prądów przy takiej samej mocy strat. 

Tranzystor IGBT występuje w dwóch zasadniczych odmianach, bez przebicia skrośnego – 
NPT (z ang. non-punch-through) i z przebiciem skrośnym – PT (z ang. punch-through). W obu 
przypadkach pojedynczy tranzystor składa się z równoległego połączenia kilkuset tysięcy 
podstawowych komórek. Przekrój takiej komórki typu NPT z częściej spotykanym kanałem typu N 
przedstawiono na rys. 1. 
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Rys. 1. Przekrój pojedynczej komórki tranzystora IGBT typu NPT z kanałem typu N 
wraz z rzędami wielkości koncentracji domieszek i grubości warstw; naniesiono 
elementy schematów zastępczych z rys. 3c–d 
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 Technologia wytwarzania tranzystora NPT-IGBT jest podobna do technologii tranzystorów 
VDMOS. Pierwsza historycznie struktura powstała w latach 1980. przez prostą modyfikację 
struktury VDMOS. Poprzez zastąpienie warstwy N+ (pełniącej rolę drenu) przez warstwę P (pełniącą 
tu rolę kolektora) uzyskano możliwość modulacji konduktywności obszaru N−. Ponieważ 
koncentracja domieszek w obszarze P jest większa od koncentracji w obszarze N−, do bazy N 
wstrzykiwane są w dużej liczbie dziury. Wynikowa koncentracja nośników staje się kilka rzędów 
wielkości większa niż koncentracja domieszek, w związku z czym konduktywność tego obszaru 
znacznie wzrasta (czyli rezystancja spada). Obserwujemy jednocześnie, że w tranzystorze IGBT, w 
przeciwieństwie do tranzystora VDMOS, mamy do czynienia z przepływem nośników obu typów 
– elektronów z emitera (który był źródłem tranzystora VDMOS) przez kanał oraz dziur 
wstrzykiwanych z kolektora. 

Tak więc zmiana typu przewodnictwa z unipolarnego na bipolarne zapewniła znaczne obniżenie 
wartości napięcia kolektor-emiter w stanie przewodzenia. Jednocześnie wysokie maksymalne 
napięcie blokowania nie uległo zmianie, gdyż w tym stanie pracy brak wstrzykiwania dziur i obszar 
N− zachowuje się tak samo, jak w tranzystorze VDMOS. Wprowadzenie nośników 
mniejszościowych poskutkowało jednak wydłużeniem czasu wyłączania przyrządu o czas 
konieczny na usunięcie nośników mniejszościowych z obszaru N− w procesie rekombinacji 
(zjawisko tzw. ogona prądowego), co z kolei wpłynęło na wzrost energii traconej w przyrządzie 
podczas wyłączania. 

2.1.b. Charakterystyki statyczne i rola końcówek 

Budowa i działanie tranzystora IGBT są dokładnie opisane w literaturze [1]. W niniejszej 
instrukcji podane zostaną jedynie wiadomości niezbędne do zrozumienia wpływu wybranych 
czynników na parametry statyczne i dynamiczne przyrządu. 

 
Rys. 2. Statyczne charakterystyki wyjściowe tranzystora NPT-N-IGBT z zaznaczonymi 
podstawowymi stanami pracy 

Rys. 2 przedstawia statyczne charakterystyki wyjściowe tranzystora NPT-IGBT  z kanałem 
typu N. Można na nich wyróżnić trzy podstawowe zakresy pracy (stany statyczne): zaworowy, 
blokowania i przewodzenia. Ponieważ tranzystory IGBT powstały dla potrzeb elektroniki mocy, w 
której dominują układy o działaniu przełączanym, zakres aktywny nie jest wykorzystywany. Nie 
dopuszcza się również pracy tranzystorów IGBT w zakresach przebicia lawinowego. Istnienie 
celowo wytworzonej struktury bipolarnej oznacza bowiem duże prawdopodobieństwo 
wystąpienia przebicia cieplnego niszczącego przyrząd. 



Tranzystor bipolarny z izolowaną bramką – IGBT B 2 ◆ 9 

© 2017 Łukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki Łódzkiej 

W celu analizy działania tranzystora IGBT najlepiej posłużyć się jednym z jego schematów 
zastępczych. W tym ćwiczeniu wystarczą dwa najprostsze, przedstawione na rys. 3c–d. Aby ułatwić 
zrozumienie roli poszczególnych elementów, zostały one naniesione na przekrój komórki 
tranzystora NPT z kanałem typu N z rys. 1. Komórkę tę można uznać za podstawową, choć 
współcześnie niekonieczne najczęściej spotykaną. 

 Jak widać, tranzystor IGBT może być rozpatrywany jako połączenie przyrządu unipolarnego 
z bipolarnym. W przypadku przyrządu N-IGBT będzie to: 

1º tranzystor N-MOSFET (patrz ćwiczenie 3 – jednak bez obszaru słabo 
domieszkowanego) i dioda (typu PIN – patrz ćwiczenie 1) – rys. 3c, 

2º lub tranzystor N-MOSFET (jak wyżej) i tranzystor BJT PNP (jednak inny niż 
wysokonapięciowy analizowany w ćwiczeniu 5 – tutaj posiada on długą bazę N− 
i krótki kolektor silniej domieszkowany niż emiter; patrz rys. 1) – rys. 3d. 

Należy sobie zdawać sprawę, że połączenie dyskretnych (oddzielnych) przyrządów nie dałoby 
dokładnie takiego samego efektu w działaniu. W rzeczywistym tranzystorze występuje bowiem 
wzajemne oddziaływanie między unipolarną a bipolarną ścieżką przewodnictwa, które nakładają się 
na siebie w tej samej objętości krzemu. 
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Rys. 3. Tranzystor IGBT z kanałem typu N:  a, b) symbole graficzne według 
normy IEC 60617;  c) schemat zastępczy z diodą PIN;  d) schemat zastępczy z 
tranzystorem PNP 

Sterowanie tranzystorem realizowane jest poprzez strukturę MOS – z wykorzystaniem 
mechanizmu polowego z izolowaną bramką. Stąd nazwa końcówki sterującej – bramka (ang. gate) 
jak w przypadku tranzystora MOSFET. Z kolei między końcówkami obwodu głównego 
występuje przewodnictwo bipolarne, dlatego nazwane zostały emiterem i kolektorem (ang. 
emitter i collector) jak w przypadku tranzystora BJT. 

Należy jednak zwrócić uwagę, że nazwy końcówek obwodu głównego odnoszą się do 
działania tranzystora IGBT jako całości. Schodząc na poziom zjawisk fizycznych w strukturze 
półprzewodnikowej można stwierdzić, że w zakresie aktywnym to dolna warstwa P, przyłączona do 
wyższego potencjału, wstrzykuje nadmiarowe dziury do warstwy N−, zaś górna warstwa przejmuje 
je poprzez pole elektryczne wstecznie spolaryzowanego złącza J2. Tak więc warstwa przyłączona do 
elektrody nazwanej kolektorem fizycznie pełni rolę emitera struktury bipolarnej i odwrotnie. 
Znajduje to odzwierciedlenie w sposobie włączenia tranzystora BJT w obwód zastępczy (rys. 3d). 
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2.2. Statyczne stany pracy 

2.2.a. Stan zaworowy 

W stanie zaworowym złącze J3 (patrz rys. 1) spolaryzowane jest zaporowo. Ponieważ między 
obszarami N− i P+ występuje duża różnica koncentracji domieszek, obszar ładunku przestrzennego 
związany z polaryzacją wsteczną rozciąga się przede wszystkim w głąb słabiej domieszkowanego 
obszaru N−. Złącze J2 spolaryzowane jest w kierunku przewodzenia, więc na obszarze bazy N− 
odkłada się w przybliżeniu całe napięcie przyłożone do przyrządu (napięcie polaryzujące 
tranzystor w typowych układach jest co najmniej 2 rzędy wielkości większe od napięcia na złączu 
PN spolaryzowanym w kierunku przewodzenia). Uproszczony obraz rozkładu natężenia pola 
elektrycznego oraz potencjału elektrycznego w tym przypadku przedstawia rys. 4a (przyjęto, że 
potencjał elektrody kolektora wynosi 0, stąd potencjał elektrody emitera jest równy napięciu UEC). 

Odwołując się do schematu zastępczego z rys. 3c, dioda jest spolaryzowana wstecznie, w 
związku z tym struktura nie może przewodzić prądu. Wartość wstecznego prądu upływu ICR (ang. 
reverse leakage current) jest rzędu ułamków mikroamperów. Moc strat jest więc pomijalnie mała. 

Struktura NPT-IGBT jest z zasady tak projektowana, aby nie zachodziło w niej przebicie skrośne 
bazy N – stąd skrót nazwy pochodzący od ang. non-punch-through IGBT. Natomiast przy pewnym 
natężeniu pola elektrycznego nośniki są rozpędzane do takiej prędkości i uzyskują taką energię 
kinetyczną, że energia oddana przy zderzeniu z węzłem sieci krystalicznej wystarcza na uwolnienie 
kolejnego elektronu, zaś elektron inicjujący nadal pozostaje swobodnym nośnikiem (nie jest 
absorbowany przez atom sieci). Po zderzeniu w strukturze są już dwa swobodne nośniki na miejsce 
jednego, z których każdy może być przyspieszony do prędkości pozwalającej na uwolnienie dalszych 
elektronów, co kończy się tzw. lawinowym powielaniem nośników. 

Gwałtownie narastająca liczba nośników powoduje, że przyrząd wychodzi ze stanu 
zaworowego i przechodzi w stan przebicia, w którym jego rezystancja jest znikomo mała i 
płynący przezeń prąd ograniczany jest wyłącznie przez obwód zewnętrzny. W przypadku 
tranzystora jest to oczywiście zjawisko niekorzystne, gdyż przestaje on pełnić funkcję otwartego 
łącznika. Za to przepływ dużego prądu przy wysokim napięciu i związana z tym generacja mocy 
może doprowadzić do przebicia cieplnego, które nieodwracalnie zniszczy tranzystor. Napięcie, przy 
którym przy złączu J3 zaczyna się powielanie lawinowe (zaczyna się ono właśnie przy złączu, gdyż 
jak widać na rys. 4a, tam natężenie pola jest największe), nazywa się napięciem przebicia w 
kierunku wstecznym. 

Zjawiska przebicia są dokładnie analizowane w ćwiczeniu 1. W tym miejscu możemy sobie więc 
pozwolić na podanie jedynie ostatecznych wyników analizy, którą można by przeprowadzić dla 
tranzystora IGBT. Podobnie jak w przypadku diody PIN, napięcie przebicia złącza PN− zależy od 
szerokości (według rys. 1 – wysokości1) i poziomu domieszkowania bazy N. Im mniejsza 
koncentracja domieszek, tym większe napięcie można przyłożyć do przyrządu bez nadmiernego 
zwiększania natężenia pola elektrycznego w bazie N. Zmniejszając domieszkowanie należy jednak 
również zwiększyć szerokość bazy N, gdyż inaczej zajdzie przebicie skrośne bazy, tzn. obszar 
ładunku przestrzennego osiągnie granicę bazy – złącze J2. 

Zaznaczone na rys. 2 napięcie przebicia w kierunku wstecznym przy zwartej bramce 
U(BR)ECS (ang. shorted gate reverse breakdown voltage) jest nieco mniejsze od napięcia przebicia 
złącza PN−. Tłumaczy to schemat zastępczy z rys. 3d – identyczne zjawisko występuje bowiem w 
wysokonapięciowych tranzystorach BJT (zob. instrukcję 5A, par. 2.2). Ogólnie rzecz biorąc, 
wzmocnienie prądowe struktury PNP wspomaga powielanie lawinowe. 

                                                      
1 Tradycyjnie w dziedzinie wysokonapięciowych przyrządów półprzewodnikowych mówi się o szerokości 

(ang. width) słabo domieszkowanej bazy, skąd oznaczenie tego wymiaru WB. Terminologia ta za punkt 
odniesienia bierze kierunek przepływu prądu głównego struktury. Jednocześnie jednak przekrój struktury 
podaje się w układzie pionowym, w związku z czym szerokość bazy jest wysokością tak narysowanej warstwy 
N−. Dla uniknięcia niejednoznaczności, będziemy mówić zawsze o wysokości warstwy N−, co będzie 
równoważne terminowi szerokość bazy. 
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Rys. 4. Uproszczony rozkład natężenia pola elektrycznego E i potencjału elektrycznego V w 
strukturze NPT-N-IGBT, przy założeniu jednorodnego domieszkowania, skokowego 
charakteru złącz i zaniedbaniu zmian w kierunku poprzecznym:  a) stan zaworowy;  b) stan 
blokowania 

Zdolność tranzystorów IGBT do blokowania napięcia w kierunku wstecznym – której 
pozbawione są tranzystory MOSFET, z zasady posiadające przeciwrównolegle włączoną diodę – nie 
w każdej aplikacji jest korzystna. Dlatego produkuje się proste moduły scalone, zawierające 
tranzystor IGBT z diodą pozwalającą na przewodzenie prądu w kierunku wstecznym (od emitera do 
kolektora). Takie przyrządy znajdują zastosowanie np. w mostkowych układach sterowania silników 
prądu stałego. 

2.2.b. Stan blokowania 

W stanie blokowania potencjał kolektora tranzystora IGBT jest dodatni w stosunku do 
potencjału emitera (UCE > 0), natomiast napięcie bramka-emiter jest mniejsze od pewnej 
charakterystycznej wartości, zwanej napięciem progowym. Zazwyczaj w przypadku przyrządów 
mniejszej mocy podaje się na tranzystor UGE = 0, natomiast dla wprowadzenia i utrzymania w stanie 
blokowania przyrządu większej mocy (szczególne w układach ze znacznymi indukcyjnościami) 
konieczne jest często podanie ujemnego napięcia UGE. 
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Ze wzajemnej polaryzacji elektrod kolektora i emitera wynika, że złącza J3 i J1 są 
spolaryzowane w kierunku przewodzenia, a złącze J2 w kierunku zaporowym. Obszar bazy N 
jest dużo słabiej domieszkowany niż obszar bazy P; podobnie więc jak w stanie zaworowym, 
ładunek przestrzenny występuje głównie w obszarze N−, na którym w uproszczeniu odkłada się 
całe napięcie kolektor-emiter. Zobrazowano to na rys. 4b (przyjęto, że potencjał elektrody 
emitera wynosi 0, stąd potencjał elektrody kolektora jest równy napięciu UCE). 

Odwołując się ponownie do schematu zastępczego z rys. 3c stwierdzamy, że dioda jest 
spolaryzowana w kierunku przewodzenia. Jednakże tranzystor MOSFET jest wyłączony, 
gdyż napięcie UGE jest mniejsze od progowego. W związku z tym struktura nie przewodzi prądu. 
Dokładnie rzecz ujmując, w stanie blokowania przez tranzystor płynie pewien prąd upływu ICES 
(prąd upływu w stanie blokowania przy zwartej bramce, ang. zero-gate-voltage forward leakage 
current), zwany też prądem odcięcia (ang. cut-off current). Przy napięciu rzędu kilkuset woltów ma 
on wartość rzędu 100 µA–1 mA (w zależności od konstrukcji konkretnego tranzystora). Wynikająca 
stąd moc strat (0,01–0,1 W) jest zwykle co najmniej 2 rzędy wielkości mniejsza niż moc strat w 
stanie przewodzenia. 

Patrząc na rys. 4b można stwierdzić, że struktura NPT-IGBT jest symetryczna pod 
względem napięcia przebicia. Napięcie przebicia związane ze złączem J2 zależy od szerokości i 
domieszkowania bazy N w identyczny sposób, jak napięcie przebicia związane ze złączem J3 i jest 
mu równe z dobrym przybliżeniem. Tu również struktura PNP wpływa na zmniejszenie 
efektywnego napięcia przebicia – napięcia przebicia w kierunku przewodzenia przy zwartej 
bramce U(BR)CES (ang. shorted gate forward breakdown voltage). 

2.2.c. Stan przewodzenia 

Dla uzyskania stanu przewodzenia potencjał kolektora musi być dodatni w stosunku do emitera 
(UCE > 0). W związku z tym złącza J3 i J1 są spolaryzowane w kierunku przewodzenia, a złącze 
J2 w kierunku zaporowym – identycznie jak w stanie blokowania. 

Drugim warunkiem jest doprowadzenie dodatniego (i odpowiednio dużego) napięcia między 
bramkę a emiter, w wyniku czego potencjał bramki staje się wyższy od potencjału obszaru P pod 
bramką (który jest zwarty z emiterem przez elektrodę, patrz rys. 1). W konsekwencji z obszaru tego 
wypychane są większościowe nośniki ładunku dodatniego (dziury), a jednocześnie przyciągane są 
doń mniejszościowe nośniki ładunku ujemnego (elektrony). Dla pewnego napięcia UGE w obszarze 
pod bramką następuje inwersja, tj. zmiana typu przewodnictwa z P na N, gdyż koncentracja 
elektronów staje się większa od koncentracji dziur. 

Przyjmuje się, że zdolność efektywnego przewodzenia prądu uzyskuje się w chwili, gdy 
koncentracja elektronów staje się równa koncentracji domieszek akceptorowych. Napięcie UGE, przy 
jakim to następuje, nazywa się napięciem progowym (ang. threshold voltage) i oznacza UGE(th). 
Warstwę inwersyjną zdolną do efektywnego przewodzenia prądu nazywa się kanałem (zob. rys. 5; 
patrz instrukcja 3A, par. 2.2). 

Po utworzeniu kanału, z uwagi na dodatnią polaryzację kolektora względem emitera, 
rozpoczyna się przepływ elektronów przez kanał z obszaru emitera w stronę kolektora, a 
więc do obszaru bazy N, co obrazują ciągłe linie na rys. 5. Jednocześnie, ze względu na polaryzację 
złącza J3 w kierunku przewodzenia, z obszaru kolektora do obszaru bazy N są wstrzykiwane 
dziury. Ponieważ oba obszary emitera N+ i kolektora P są silniej domieszkowane niż baza, do bazy 
napływa duża liczba elektronów i dziur nadmiarowych, przez co koncentracja nośników w bazie 
bardzo znacząco wzrasta. W konsekwencji rośnie konduktywność obszaru bazy N i spada jej 
rezystancja. 

Co istotne, koncentracja nośników nadmiarowych zależy od intensywności ich wstrzykiwania. 
Ta zaś rośnie wraz ze wzrostem prądu przewodzonego przez strukturę. Tym samym konduktywność 
obszaru bazy N rośnie ze wzrostem prądu, co nazywamy modulacją konduktywności bazy (patrz 
instrukcja 0, par. 6.5). 

Prąd Imos płynący przez kanał zależy od przyłożonego napięcia UGE identycznie jak w zwykłym 
tranzystorze MOSFET: 
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gdzie: µns – ruchliwość elektronów w obszarze pod bramką, Cox – pojemność tlenku bramki na 
jednostkę powierzchni, L – długość kanału podstawowej komórki, W – szerokość kanału (de facto 
suma szerokości kanałów wszystkich komórek podstawowych). 
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Rys. 5. Mechanizm przewodzenia prądu w strukturze 
IGBT: linie ciągłe – przepływ elektronów, linie 
przerywane – przepływ dziur (dla przejrzystości linie 
naniesiono w połowie komórki, w drugiej połowie 
przepływ jest symetryczny) 

Napięcie na przyrządzie jest natomiast większe, niż to wynika z charakterystyki części MOS, 
gdyż dochodzi jeszcze spadek potencjału na obszarze bazy N i złączu J3. Z tego punktu widzenia 
tranzystor IGBT zachowuje się jak dioda PIN (P+N−N+), z tym, że elektrony z emitera N+ do 
bazy N− nie są bezpośrednio wstrzykiwane, lecz dostają się przez kanał tranzystora MOSFET. 
Ideę tę przedstawia schemat zastępczy z rys. 3c. 

Prosty schemat z rys. 3c nie uwzględnia jednak istnienia pionowej struktury PNP, działającej jak 
tranzystor bipolarny złączowy (BJT). Zwróciliśmy już uwagę (par. 2.1.b), że tranzystor ten jest 
włączony „na odwrót”, gdyż jego emiter jest kolektorem tranzystora IGBT, a kolektor – emiterem 
tranzystora IGBT (por. rys. 1 i 3d). 

Bazą tranzystora PNP jest dren części MOS (baza N tranzystora IGBT). W związku z tym 
przepływ prądu Imos powoduje wysterowanie bazy tranzystora PNP i tranzystor ten 
przechodzi w stan przewodzenia. Fizycznie wynika to z faktu, że część dziur wstrzykiwanych z 
obszaru kolektora struktury IGBT (emiter tranzystora PNP) nie rekombinuje w bazie z elektronami 
tworzącymi prąd części MOS, ale jest porywana przez pole elektryczne wstecznie spolaryzowanego 
złącza J2 i trafia do obszaru P+ pod elektrodą emitera struktury IGBT (kolektor tranzystora PNP; 
patrz rys. 5). W ten sposób utworzona zostaje druga ścieżka przepływu prądu od kolektora do 
emitera. Prąd płynący tą drogą oznaczymy przez Ipnp. 

Działanie składowego tranzystora PNP można scharakteryzować poprzez statyczne 
wzmocnienie prądowe w konfiguracji wspólnej bazy2: 

                                                      
2 Do oznaczeń końcówek tranzystora składowego PNP dodano indeks „pnp”, aby nie pomylić ich z 

końcówkami całej struktury IGBT, z której punktu widzenia pełnią one dokładnie odwrotne role. 
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Dzięki utworzeniu ścieżki dla prądu Ipnp uzyskujemy więc większy prąd przewodzenia przy 
danym napięciu kolektor-emiter (niżby to wynikało z szeregowego połączenia struktur MOS i 
PIN). 

Przyjęcie szeregu uproszczeń pozwala na wyprowadzenie prostej zależności 
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α
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2
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gdzie: WB(eff) – efektywna szerokość bazy tranzystora PNP (szerokość bazy N po odjęciu szerokości 
obszaru ładunku przestrzennego związanego z zaporowo spolaryzowanym złączem J2), Da – 
ambipolarna stała dyfuzji (zależy od ruchliwości dziur i elektronów), τ – czas życia nośników 
nadmiarowych w bazie N. Ze wzoru tego wynika, że im węższa baza i dłuższy czas życia 
nośników, tym większe wzmocnienie tranzystora. Jest to logiczne, gdyż jeżeli nośniki mają do 
pokonania krótszą drogę oraz rekombinują po dłuższym czasie, to większe jest prawdopodobieństwo 
ich dotarcia do kolektora (tranzystora PNP) zanim zrekombinują. 

W typowych tranzystorach IGBT wzmocnienie prądowe αpnp jest stosunkowo niskie. 
Wynika to ze słabego domieszkowania emitera PNP (gdyż jest to kolektor tranzystora IGBT) oraz 
dużej szerokości bazy N (wysokości warstwy N−). Może ono być rzędu 0,5 lub jeszcze mniejsze, 
zależy to jednak silnie od konstrukcji konkretnego tranzystora. Fakt ten jest niekorzystny dla 
stanu przewodzenia, gdyż oznacza zmniejszenie prądu kolektora (przy danym napięciu UCE) 
zgodnie z zależnością (2.4). Jednakże z punktu widzenia procesu wyłączania niekorzystne jest z kolei 
zbyt duże wzmocnienie, co zostanie stwierdzone w par. 2.3. 

2.2.d. Charakterystyki statyczne stanu przewodzenia 

Schemat zastępczy z diodą PIN pokazuje jasno, że spadek potencjału na przewodzącej strukturze 
IGBT jest sumą spadku na części MOS (tj. kanale) oraz spadku na części PIN (tj. bazie N wypełnionej 
nośnikami nadmiarowymi oraz złączu J3). Zrozumiała jest więc obecność na charakterystyce 
wyjściowej charakterystycznego kolana (ang. knee, patrz rys. 2), o które przesunięta zostaje 
typowa charakterystyka tranzystora MOSFET. Powodem występowania kolana jest oczywiście fakt, 
że do przepływu jakiegokolwiek prądu między kolektorem a emiterem (tranzystora IGBT) niezbędne 
jest przekroczenie napięcia progowego złącza PN−. 

Schemat z diodą nie tłumaczy jednak, dlaczego nachylenie charakterystyki w zakresie 
nasycenia jest dużo większe (mniejsza rezystancja różniczkowa) niż nachylenie 
charakterystyki tranzystora MOSFET w zakresie liniowym. Można to wyjaśnić dopiero w 
oparciu o schemat z tranzystorem BJT (rys. 3d). Zauważmy, że schemat z rys. 3c jest dokładnie jego 
fragmentem, obejmującym tranzystor MOSFET i złącze baza-emiter. Schemat ten nie uwzględnia 
więc istnienia obwodu emiter-kolektor. 

Tymczasem rezystancja emiter-kolektor tranzystora BJT wysterowanego odpowiednio dużym 
prądem bazy jest dużo mniejsza niż rezystancja tranzystora MOSFET, a dodatkowo spada ona ze 
wzrostem prądu kolektora (modulacja konduktywności). Wynika to z obecności nośników 
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nadmiarowych i bipolarnego charakteru przewodnictwa. Dlatego charakterystyka wyjściowa 
tranzystora IGBT w stanie nasycenia ma przebieg bliższy tranzystorowi BJT. Warunkiem jest 
tylko odpowiednio duży prąd tranzystora MOSFET (a więc odpowiednio wysokie napięcie UGE i 
duży sumaryczny prąd IC), niezbędny do wprowadzenia tranzystora BJT w stan nasycenia. Z reguły 
ma to miejsce już od kilku procent znamionowego prądu kolektora. 

Również przebieg charakterystyk wyjściowych w stanie aktywnym (dla odpowiednio 
dużych wartości IC) jest typowy dla tranzystora BJT – charakterystyki tranzystora IGBT, w 
odróżnieniu od wysokonapięciowego tranzystora MOSFET, wykazują niezerowe nachylenie. 
Fizycznie wynika to ze zmniejszania efektywnej szerokości bazy N WB(eff) pod wpływem 
rozszerzania się obszaru ładunku przestrzennego złącza J2 (im większe napięcie UCE, tym dalej sięga 
obszar ładunku przestrzennego). Efektywne skrócenie bazy powoduje wzrost wzmocnienia 
prądowego tranzystora BJT [patrz zależność (2.5)] – a więc wzrost prądu części PNP i w 
konsekwencji prądu kolektora zgodnie z równaniem (2.4). 
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2.3. Przełączanie 

2.3.a. Rozważany układ pracy 

Przebieg procesów dynamicznych podczas przełączania tranzystora IGBT zostanie omówiony na 
przykładzie najprostszego układu – łącznika z jednym tranzystorem i obciążeniem o charakterze 
rezystancyjnym w postaci opornika RL (rys. 6). Nie jest to przypadek najbardziej typowy dla 
tranzystora IGBT, gdyż pracuje on zwykle z obciążeniem indukcyjnym; jednakże pozwoli w 
największym uproszczeniu prześledzić zjawiska w stanach dynamicznych. Kondensatory CGE i CGC 
przedstawiają wewnętrzne pasożytnicze pojemności tranzystora. Opornik RG reprezentuje 
sumaryczną rezystancję obwodu bramki. Sterowania jest realizowane przez źródło impulsów 
prostokątnych napięcia ug o poziomie wysokim UGG(on) > UGE(th) i poziomie niskim UGG(off); dla 
uproszczenia przyjmiemy UGG(off) = 0 V. Zasilanie obwodu mocy stanowi źródło napięcia stałego o 
wartości UCC. 

Idealizowany obraz przebiegów w układzie z rys. 6 przedstawia rys. 7. 

 

CGE 

iC 

ug 

UCC 

RL 

CGC 

uGE 

RG uCE 

Rys. 6. Układ pracy tranzystora IGBT z obciążeniem 
rezystancyjnym z zaznaczonymi elementami 
pasożytniczymi istotnymi dla stanów dynamicznych 

2.3.b. Załączanie 

W chwili t0 napięcie generatora sygnału bramkowego ug narasta w krótkim czasie do wartości 
UGG(on). W wyniku tego generator dostarcza ładunek do pojemności CGE ze stałą czasową 
wynikającą z wartości RG i CGE. Ponieważ potencjał kolektora pozostaje stały, musi również mieć 
miejsce odbieranie ładunku z pojemności CGC. To drugie zjawisko nie wpływa jednak znacząco na 
przebiegi z powodu niskiej wartości nieliniowej pojemności CGC w tej chwili. 

Pojemności pasożytnicze CGE i CGC tranzystora IGBT są związane ze strukturą MOS i 
dlatego mają identyczną genezę i charakter oraz zbliżone właściwości do pojemności CGS i 
CGD tranzystora VDMOS. Zostały one szczegółowo opisane w instrukcji 3A (rozdz. 2). Tak więc 
pojemność CGE jest pojemnością liniową związaną z układami: bramka – tlenek – obszar źródła N+ 
oraz metalizacja bramki – tlenek – metalizacja  źródła (emitera IGBT). Z kolei pojemność CGC jest 
nieliniową pojemnością wykazującą silną, malejącą zależność od napięcia UCE. Stąd podany wyżej 
wniosek o niskiej wartości pojemności, jako że napięcie UCE w rozważanym etapie załączania 
pozostaje wysokie. 

Napięcie bramka-emiter narasta do momentu osiągnięcia wartości napięcia progowego UGE(th) w 
chwili t1. W obszarze P pod bramką bardzo szybko indukuje się wówczas kanał. W wyniku tego 
rezystancja obwodu głównego tranzystora (kolektor-emiter) znacznie spada – z wartości 
rzędu megaomów do kilku omów, co odpowiada zasadniczo rezystancji warstwy N−. Do napięcia 
odłożonego na tej rezystancji dodaje się oczywiście spadek potencjału na złączu J3, jednak jego 
udział w napięciu uCE jest w tej chwili niewielki. Rezystancja kolektor-emiter staje się więc 
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porównywalna z typową rezystancją obciążenia i napięcie uCE szybko spada na zasadzie 
dzielnika napięcia. 

t
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Rys. 7. Przebiegi uGE, uCE i iC w cyklu przełączania tranzystora IGBT z obciążeniem rezystancyjnym 

W chwili t2 część MOS tranzystora jest już załączona i baza tranzystora PNP jest wysterowana. 
Bezwładność części bipolarnej jest jednak dużo większa. W bazie tranzystora PNP znajduje się 
znikoma ilość nośników nadmiarowych, z czego wynika stosunkowo duża rezystancja i nadal 
wysoki spadek potencjału na przyrządzie. Z napięciowego prawa Kirchhoffa wartość prądu 
kolektora wynosi zawsze 

 
L

CECC
C

R

uU
i

−
= . (2.6) 

W przypadku idealnego łącznika uCE = 0, więc 
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jednak w rozważanym momencie stan taki nie został jeszcze osiągnięty. Prąd kolektora nie osiąga 
więc jeszcze swojej maksymalnej wartości, bliskiej IC(id). 

Jednakże w miarę napływu do bazy elektronów z emitera i dziur z kolektora, konduktywność 
obszaru N− rośnie, co skutkuje dalszym zmniejszaniem się spadku potencjału na przyrządzie. 
W wyniku tego prąd kolektora rośnie zgodnie z równaniem (2.6), co – jak wynika z analizy 
bipolarnego przewodnictwa dyfuzyjnego – powoduje dalszy wzrost konduktywności i jeszcze 
większe zmniejszenie spadku potencjału. 

W chwili t3 napięcie kolektor-emiter ustala się na niskiej wartości w stanie nasycenia UCE(sat). Jak 
wynika z charakterystyki wyjściowej tranzystora, w zakresie nasycenia dalsze zwiększanie napięcia 
uGE nie powoduje już znaczącego spadku napięcia uCE. W zależności od wartości prądu Io i napięcia 
uGE, napięcie UCE(sat) wynosi zwykle od 0,5 V do 3 V. Skoro napięcie uCE ustala się, to również prąd 
kolektora osiąga wartość ustaloną Io narzuconą przez obwód zewnętrzny (Io ≈ IC(id)). 

W związku ze zmniejszaniem się potencjału kolektora w przedziale t1–t3, musi nastąpić 
rozładowanie pojemności CGC – silnie nieliniowej pojemności złączowej złącza J2 (rys. 1). Posiada 
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ona w tej chwili dużą wartość (zwiększającą się wraz ze zmniejszaniem napięcia uCE), dodatkowo 
widzianą na wejściu zmultiplikowaną przez wzmocnienie napięciowe tranzystora (efekt Millera). 
Skutkiem tego jest bardzo znaczne zwiększenie stałej czasowej ładowania bramki, co znajduje 
odzwierciedlenie w charakterystycznym załamaniu na przebiegu napięcia uGE. 

Zatrzymanie opadania napięcia uCE w chwili t3 oznacza zmniejszenie wzmocnienia napięciowego 
tranzystora do zera i efekt Millera zanika. Pojemność wejściowa spada i napięcie uGE zaczyna 
ponownie szybko narastać do wartości UGG(on) wymuszonej przez generator. Szybkość 
narastania jest jednak mniejsza niż w przedziale t0–t1, gdyż pojemność CGD ma obecnie (przy 
mniejszym napięciu uCE) większą wartość. Stan ustalony w obwodzie bramki zostaje osiągnięty w 
chwili t4. 

W chwili t4 kończą się więc wszelkie stany nieustalone związane z załączaniem struktury 
IGBT, które rozpoczęły się w chwili t0. Jeżeli jednak rozpatruje się tranzystor w sposób uproszczony 
jako łącznik, to istotny jest wyłącznie obwód główny (kolektor-emiter). Z tego punktu widzenia 
załączanie trwa wyłącznie do chwili t3, kiedy to tranzystor uzyskuje zdolność przewodzenia 
pełnego prądu obciążenia Io. Dlatego czas od t0 do t3 nazywa się czasem załączania tranzystora ton. 

Wyróżnia się przy tym czas właściwego załączania obwodu głównego – czas narastania tr oraz 
czas opóźnienia przy załączaniu td(on). Czas tr można podzielić na dwa odcinki według kryterium 
napięcia uCE: czas opadania napięcia wynikający z załączenia części MOS tfu,mos oraz czas opadania 
napięcia wynikający z załączania części bipolarnej tfu,bip. 

2.3.c. Wyłączanie 

Proces wyłączania tranzystora rozpoczyna się w chwili t5, gdy napięcie generatora ug w krótkim 
czasie opada do wartości UGG(off). W wyniku tego przeładowują się pojemności CGE i CGC. Dopóki 
ładunek bramki jest większy od niezbędnego do pracy części MOS w zakresie liniowym, w obwodzie 
głównym nie obserwujemy prawie żadnych zmian (może wystąpić nieznaczne zwiększenie napięcia 
uCE ze względu na zależność od uGE). 

W chwili t6 część MOS wchodzi w zakres nasycenia, czyli zaczyna się jej wyłączanie: rezystancja 
rośnie, spada więc prąd. Jednocześnie rośnie napięcie uCE, gdyż na zasadzie dzielnika napięcia, 
mniejsze napięcie odkłada się na rezystancji obciążenia. Szybkość wzrostu napięcia uCE jest 
zasadniczo zależna od szybkości usuwania nośników z obszaru N− przy złączu J2, gdzie musi 
powstać obszar ładunku przestrzennego wynikający z polaryzacji zaporowej napięciem o znacznej 
wartości. Wyłączanie części MOS kończy się w chwili t7, kiedy napięcie uGE spada poniżej 
wartości progowej UGE(th) i zanika kanał. Prąd części MOS nie może więc już płynąć. 

W przybliżeniu można uznać, że ze względu na dużą bezwładność mniejszościowych dziur w 
bazie N, do chwili t7 druga składowa prądu kolektora nie zdążyła się znacząco zmienić. Dlatego prąd 
kolektora osiąga wartość 
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W bazie N nadal są obecne nośniki nadmiarowe, co powoduje, że przepływ prądu kolektora 
jest podtrzymywany aż do chwili t9, gdy wszystkie one zrekombinują. Rekombinacja odbywa 
się w warstwie N−, jak również w warstwie P kolektora. Wynika to z występowania wstecznego 
wstrzykiwania elektronów z warstwy N− do warstwy P – różnica koncentracji domieszek między 
obszarami N− i P (w strukturze NPT) nie jest bowiem bardzo duża. 

Dokonujące się w ten sposób wyłączanie tranzystora składowego PNP jest wyraźnie dłuższe, niż 
dla tranzystora dyskretnego. Nie ma bowiem możliwości usunięcia nośników nadmiarowych 
przez przepływ wstecznego prądu bazy. Przepływ taki jest skutecznie blokowany przez 
wyłączony tranzystor składowy MOS. Wynikający stąd charakterystyczny, wydłużony kształt prądu 
kolektora dał temu fragmentowi przebiegu nazwę ogona prądowego (ang. current tail). 

Czas zaniku ogona prądowego od chwili t7 do t9 może być nawet rzędu mikrosekund. Jest on w 
przybliżeniu proporcjonalny do czasu życia nośników nadmiarowych τ w bazie N. Prąd wyrażony 
wzorem (2.8) jest wysokością ogona prądowego, który przyjęło się oznaczać indeksem „z”. 
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Występowanie ogona prądowego oznacza przepływ prądu wyjściowego przy wysokim napięciu 
kolektor-emiter, co powoduje znaczący wzrost energii wydzielanej podczas wyłączania 
przyrządu (w stosunku do energii już wydzielonej do chwili t7). Ta dodatkowa energia jest 
proporcjonalna do napięcia w stanie wyłączenia (blokowania), wysokości ogona prądowego i czasu 
życia nośników: 

 τατ ⋅⋅⋅=⋅⋅∝ opnpCCzCE(off)z)C(off, IUIUW . (2.9) 

Występowanie ogona prądowego jest więc zjawiskiem niekorzystnym. Duża część badań 
nad strukturami IGBT dotyczy minimalizacji ogona prądowego – zmniejszenia wysokości i 
skrócenia czasu zaniku. Niestety znaczne zmniejszenie czasu życia nośników τ w strukturze NPT nie 
jest możliwe, gdyż spowodowałoby nieakceptowalny wzrost rezystancji obszaru N− w stanie 
przewodzenia. Ze względu na wzrost napięcia UCE w stanie przewodzenia, nie można również 
znacząco zmniejszyć wzmocnienia prądowego αpnp. 

Z przeprowadzonej powyżej analizy wynika, że od chwili t7 napięcie uGE nie ma już żadnego 
wpływu na działanie tranzystora. Opada ono do wartości UGG(off) z szybkością wynikającą z 
rozładowywania pojemności wejściowej (głównie CGE) tranzystora. Proces ten kończy się w chwili 
t8. 

Wyłączanie tranzystora IGBT rozpatrywanego jako łącznik – a więc z punktu widzenia 
obwodu głównego – kończy się dopiero, gdy całkowicie zanika ogon prądowy. Stąd czas 
wyłączania toff wyznaczany jest od chwili t5 do t9. Można w nim wyróżnić czas opóźnienia przy 
wyłączaniu td(off) i czas opadania (prądu) tf. Ponieważ na czas opadania składają się dwa procesy o 
znacznie różnym czasie trwania, wyróżnia się w nim odcinek związany z wyłączaniem struktury 
MOS tf,mos oraz odcinek związany z ogonem prądowym tz. 
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2.4. Inne struktury tranzystorów IGBT 

2.4.a. Tranzystor PT-IGBT 

Analiza działania tranzystora IGBT została oparta na strukturze NPT-N-IGBT. Jak już jednak 
wspomniano w par. 2.1.a, równolegle produkowane są tranzystory z przebiciem skrośnym 
PTNIGBT (ang. punch-through IGBT), a także – głównie jako części układów scalonych – 
tranzystory o strukturze poziomej LIGBT (ang. Lateral IGBT). Układy scalone mocy są odrębnym, 
szerokim zagadnieniem, które wykracza poza zakres niniejszego przedmiotu. Natomiast tranzystory 
PTIGBT są dość popularne, szczególnie w aplikacjach małej i średniej mocy (jak spotykane w 
laboratorium). 

Najważniejszym elementem struktury tranzystora PTIGBT odróżniającym go od 
NPTIGBT jest dodatkowa, niezbyt wysoka warstwa N+, zwana buforem, znajdująca się między 
kolektorem P+ a bazą N−. Ta drobna z pozoru modyfikacja ma bardzo duży wpływ zarówno na 
działanie tranzystora, jak i na proces produkcyjny. W stanie blokowania jej zadaniem jest 
uodpornienie tranzystora na przebicie skrośne bazy N− dzięki zmianie układu warstw PN−P+ na 
PN−N+P+ (patrz instrukcja 0, par. 5.3). Z tej właściwości wynika nazwa przyrządu. 

Aby tranzystor PT-IGBT działał poprawnie bez utraty korzystnych właściwości, musi być on 
wykonany z większą precyzją (niż tranzystor NPTIGBT) co do wysokości i domieszkowania 
warstw. Zwiększa to oczywiście jego koszt, jednak w licznych zastosowaniach zalety 
tranzystora PT-IGBT kompensują tę wadę. Te zalety to: 

� zwiększenie początkowego spadku prądu w czasie wyłączania, czyli 
zmniejszenie wysokości ogona prądowego; 

� skrócenie ogona prądowego w wyniku szybszej rekombinacji nośników; 

� większa wytrzymałość napięciowa przy tych samych wymiarach struktury. 

Oprócz ceny, głównymi wadami tranzystora PT-IGBT są z kolei: 

� większy spadek potencjału na obszarze bazy N (przy takim samym prądzie 
tranzystora NPT-IGBT), a więc większe napięcie kolektor-emiter i większa moc 
strat w stanie przewodzenia; 

� bardzo mała (rzędu kilkunastu woltów) wytrzymałość napięciowa w kierunku 
wstecznym (zakres zaworowy) – tranzystory te nie nadają się do aplikacji, w 
których napięcie na łączniku może mieć zmienną polaryzację; 

� mniejsza odporność na szybkie stany przejściowe (np. przepięcia) i większe 
niebezpieczeństwo przebicia cieplnego. 

Z powodu różnicy w zdolności blokowania napięcia w obu kierunkach, struktura PT nazywana jest 
często niesymetryczną w odróżnieniu od NPT – zwanej symetryczną. 

Współcześnie produkowane tranzystory NPTIGBT i PTIGBT posiadają w rzeczywistości 
struktury bardziej złożone niż analizowane w niniejszej instrukcji. Ich zadaniem jest eliminacja lub 
ograniczenie wad struktur podstawowych. Szczególne znaczenie ma to dla tranzystorów NPTIGBT, 
których popularność na powrót wzrosła. 

2.4.b. Tranzystory komplementarne 

Dla każdej z wymienionych wcześniej struktur (NPT-IGBT, PT-IGBT, LIGBT) produkowane są 
też tranzystory komplementarne z kanałem typu P. Są one jednak rzadziej spotykane, gdyż duża 
część aplikacji może być oparta na samych tylko tranzystorach N-IGBT. 

Co jednak ważne, tranzystory P-IGBT mogą być stosowane bez dodatkowych ograniczeń. 
Jest to istotna zaleta w stosunku do tranzystorów MOSFET, wśród których przyrządy z kanałem 
typu P – ze względu na mniejszą ruchliwość dziur niż elektronów – posiadają większą rezystancję, a 
więc większa jest moc strat (przy takich samych wymiarach przyrządu). Natomiast w tranzystorach 
IGBT niezależnie od typu kanału w przewodzeniu biorą udział nośniki obu typów i nie obserwujemy 
znaczących różnic między tranzystorami N- i P-IGBT. 
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2.5. Parametry dynamiczne tranzystora IGBT 

2.5.a. Parametry czasowe 

Aby umożliwić użytkownikowi porównanie różnych tranzystorów pod względem właściwości 
dynamicznych, dla tranzystorów IGBT określa się szereg parametrów czasowych. Są to parametry 
identyczne jak dla pozostałych tranzystorów mocy (patrz instrukcja 3A, par. 2.5): 

1) czas opóźnienia przy załączaniu td(on), 

2) czas narastania tr, 

3) czas opóźnienia przy wyłączaniu td(off), 

4) czas opadania tf, 

5) czas załączania ton, 

6) czas wyłączania toff. 

Jak uzasadniono w instrukcji 3A, do wyznaczania powyższych parametrów jako danych 
katalogowych, ze względów praktycznych konieczne jest stosowanie definicji technicznych, w 
których zamiast idealnych stanów ustalonych rozpatruje się chwile osiągnięcia 
charakterystycznych wartości względnych przebiegów 10% i 90%. Dla tranzystora IGBT 
definicje te zawiera norma IEC 607479, a zobrazowane zostały one na rys. 8. Według normy, dla 
tranzystora IGBT wartość względna oznacza wartość bezwzględną (liczoną od zera) odniesioną do 
początkowej lub końcowej wartości ustalonej (w zależności od tego, którego procesu przejściowego 
dotyczy dany parametr). 

Działanie tranzystora IGBT różni się od działania tranzystora MOSFET, co wynika z bipolarnego 
charakteru przewodnictwa w tym pierwszym. O czasie trwania procesów przejściowych 
decydują zjawiska związane z napływem i usuwaniem nośników nadmiarowych z obszaru 
słabo domieszkowanego, a więc z przepływem prądu. Dlatego w odróżnieniu od tranzystora 
MOSFET, w przypadku tranzystora IGBT przebiegiem głównym odniesienia jest nie napięcie, a prąd 
(kolektora). Natomiast ponieważ mechanizm sterowania jest taki sam – napięciowo-ładunkowy, 
przebiegiem sterującym odniesienia jest również napięcie (bramka-emiter). Powoduje to, że czas 
narastania i czas opadania opisują faktyczną szybkość narastania i opadania przebiegu odniesienia 
(iC), podczas gdy dla tranzystora MOSFET opisywały one procesy odwrotne – opadanie i narastanie 
napięcia głównego uDS. 

Wobec powyższego, rozpatrywane wartości względne można formalnie opisać wzorami: 
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Natomiast definicje parametrów technicznych można wyrazić słownie następująco: 

— czas opóźnienia przy załączaniu td(on) – to czas od chwili, w której wartość 
względna uGE(r) narastającego napięcia uGE osiąga 10%, do chwili, w której 
wartość względna iC(r) narastającego prądu iC osiąga 10%; 

— czas narastania tr – to czas, w którym wartość względna prądu iC wzrasta od 
10% do 90%; 

— czas opóźnienia przy wyłączaniu td(off) – to czas od chwili, w której wartość 
względna opadającego napięcia uGE osiąga 90%, do chwili, w której wartość 
względna opadającego prądu iC osiąga 90%; 

— czas opadania tf – to czas, w którym wartość względna prądu iC spada od 90% 
do 10%. 
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Rys. 8. Techniczne definicje czasowych i energetycznych parametrów dynamicznych tranzystora IGBT według 
normy IEC 607479  

Jak wiadomo, szczególnie specyficzny przebieg ma proces wyłączania tranzystora IGBT. 
Obserwowany jest bowiem ogon prądowy, tzn. bardzo powolne opadanie prądu iC w końcowej fazie. 
Powoduje ono, że czas opadania tf definiowany technicznie (rys. 8) może nie obejmować dużej 
części ogona prądowego, a tym samym może znacząco różnić się od faktycznego czasu trwania 
fizycznego procesu wyłączania tranzystora tf (rys. 7). Wpływa to z kolei w analogiczny sposób na 
wartość czasu wyłączania toff, definiowanego zawsze jako suma czasów td(off) i tf. W praktyce czas tf 
wyznaczony według definicji technicznej będzie bliższy samemu tylko czasowi tf,mos, związanemu z 
wyłączaniem składowego tranzystora MOSFET (patrz rys. 7). Z tego powodu dla tranzystora IGBT 
definiuje się dodatkowy parametr techniczny – czas ogona prądowego tz (ang. tail time), jako czas, 
w którym wartość względna prądu iC spada od 10% do 2%. 

Dla tranzystorów IGBT charakterystyczna jest praca z obciążeniem indukcyjnym i dużymi 
natężeniami prądów. Ponieważ powoduje to powstawanie zaburzeń napięcia sterującego uGE, 
tranzystory te są często sterowane dwubiegunowo napięciem o znaczącej amplitudzie, tzn. poziom 
załączający UGE(on) > 0 (rys. 7), zaś poziom wyłączający UGE(off) < 0. Dzięki temu nawet zakłócone 
napięcie uGE pozostanie odpowiednio wyższe lub niższe od wartości progowej – której przekroczenie 
wywołałoby niepożądane przełączenie przyrządu. Niemniej, jak widać na rys. 8, napięcie UGE(off) nie 
ma wpływu na definicję wartości względnej napięcia uGE, która liczona jest od poziomu zera [por. 
wzór (2.10)]. 

Z powyższych powodów, norma nakazuje pomiar parametrów dynamicznych (zarówno 
czasowych, jak i energetycznych) właśnie przy obciążeniu indukcyjnym i sterowaniu 
dwubiegunowym. Odzwierciedla się to w przebiegu krzywych na rys. 8. Niemniej w niniejszym 
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ćwiczeniu dokonany on zostanie dla obciążenia rezystancyjnego i sterowania jednobiegunowego, z 
szeregu powodów: 

1º dla uproszczenia zasady działania i obsługi układu laboratoryjnego, które dla 
obciążenia indukcyjnego musiałyby być znacznie bardziej złożone, co 
uniemożliwiłoby wykonanie pomiarów w czasie trwania zajęć laboratoryjnych; 

2º dla uproszczenia zasilania obwodu sterowania, podczas gdy dwubiegunowość 
napięcia uGE nie wpłynęłaby na zasadnicze wyniki doświadczenia, tj. na 
zmienność parametrów czasowych w funkcji rezystancji bramkowej (należy 
jednak wiedzieć, że wpłynęłaby na wartości tych parametrów jako takie); 

3º dla minimalizacji zaburzeń, które utrudniłyby dokonanie odczytów i obniżyłyby 
wiarygodność wyników; 

4º dla zwiększenia słuszności porównania z tranzystorem MOSFET, dla którego 
norma nakazuje pomiar parametrów czasowych z obciążeniem rezystancyjnym. 

Mimo zastosowania obciążenia rezystancyjnego, w układzie pomiarowym mogą występować 
zjawiska pasożytnicze powodujące, że definicyjny poziom napięcia lub prądu będzie przekraczany 
kilkakrotnie. Sytuację taką zobrazowano na rys. 8 dla napięcia uCE podczas wyłączania. Jak 
uzasadniono w instrukcji 3A, w takim wypadku odczytując parametry dynamiczne należy zawsze 
brać pod uwagę pierwsze przecięcie danego poziomu przez odpowiedni przebieg. 

2.5.b. Parametry energetyczne 

Czas opadania, a więc i czas wyłączania, nigdy nie uwzględnia całego ogona prądowego z 
powodu jego bardzo łagodnego zaniku. Powoduje to, że właściwości tranzystora IGBT w zakresie 
szybkości wyłączania nie mogą być dobrze opisane za pomocą tych parametrów. Nawet 
stosowanie parametru tz – wyznaczanego w oparciu o próg iC(r) = 2% – nie poprawia sytuacji 
znacząco, gdyż rezultat jest nadal niedokładny. Wynika to z faktu, że przy małym nachyleniu 
zbocza iC nawet niewielka pomyłka w odczycie wartości iC(r) wywoła dużą różnicę w wyznaczonej 
wartości tz. Tymczasem w przypadku zaszumionych wolno zmiennych przebiegów trudno jest o 
dokładne określenie momentu osiągnięcia wartości charakterystycznej. Z tego powodu szczególne 
znaczenie dla tranzystorów IGBT mają parametry energetyczne, dające projektantowi układu 
kompletną informację o najistotniejszych skutkach takiego a nie innego przebiegu zjawisk 
dynamicznych. 

Dodatkowo czas przełączania i energia wydzielana w tranzystorze IGBT w stanach 
dynamicznych są w większym stopniu (niż dla tranzystora MOSFET) narzucone przez sam 
tranzystor (procesy związane z nośnikami nadmiarowymi wewnątrz struktury) niż przez obwód 
zewnętrzny. Wszelkie zależności z tym związane są złożone i obejmują wiele parametrów. Z tego 
powodu energia wydzielana podczas przełączania nie może być prosto oszacowana z zależności 
analitycznych w oparciu o czasy przełączania (por. instrukcję 3A, par. 3.3). Jest to kolejny powód, 
dla którego parametry energetyczne stanowią istotne parametry tranzystora IGBT i są zawsze 
podawane w kartach katalogowych, niezależnie od parametrów czasowych. 

Energia wydzielana Wd w danym stanie pracy jest równa całce z mocy chwilowej pd 
wydzielanej w tranzystorze, obliczonej za czas trwania tego stanu ∆t: 

 ∫=
t

tpW
Δ

dd d . (2.12) 

W tranzystorze polowym z izolowaną bramką, jakim jest IGBT, energia wydzielana w obwodzie 
sterowania jest zaniedbywalnie mała w porównaniu z energią wydzielaną w obwodzie głównym. Z 
tego powodu przyjmuje się, że moc strat w tranzystorze jest równa mocy strat w obwodzie 
kolektora: 

 CECCGC uipppp =≈+=  (2.13) 
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Uproszczony przebieg mocy chwilowej strat w obwodzie kolektora pC zsynchronizowany z 
przebiegami napięć i prądu przedstawiony został na dolnym wykresie na rys. 8. Moc strat w stanie 
przewodzenia oblicza się jako 

 CE(sat)oC(cond) UIP =  (2.14) 

gdzie Io jest prądem obciążenia, zaś wartość napięcia kolektor-emiter w stanie nasycenia UCE(sat) dla 
tego prądu odczytuje się z katalogowej charakterystyki wyjściowej IC = f(UCE). Natomiast moc strat 
w stanach dynamicznych załączania i wyłączania można uzyskać wyłącznie przez pomiar i 
wymnożenie przebiegów prądu iC i napięcia uCE w konkretnym układzie i warunkach pracy. 
Energia wydzielona w tych stanach wyraża się więc zależnościami: 

 ∫∫∫ ===
sup(on)

inf(on)on)int(on)int(

ddd CECCECCC(on)
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ttt

tuituitpW  (2.15) 
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ddd CECCECCC(off)

t

ttt

tuituitpW  (2.16) 

gdzie tint(on) i tint(off) są przedziałami całkowania odpowiadającymi odpowiednio procesowi załączania 
i wyłączania w odniesieniu do obwodu głównego, a więc odcinkom czasu, na których zmieniają się 
wartości chwilowe przebiegów uCE i iC; natomiast tsup(on) i tinf(on) oraz tsup(off) i tinf(off) są granicami tych 
przedziałów całkowania. 

Podobnie jak w przypadku parametrów czasowych, bipolarny charakter przewodnictwa ma 
także wpływ na sposób wyznaczania parametrów energetycznych. W tym względzie istotne 
jest, iż: 

� dla stanu załączania – przebieg napięcia uCE na odcinku tfu,bip (rys. 7) opada stosunkowo 
powoli w miarę wzrostu koncentracji nośników nadmiarowych gromadzonych w 
obszarze słabo domieszkowanym, jak to opisano w par. 2.3.b; 

� dla stanu wyłączania – przebieg prądu iC wykazuje ogon prądowy (odcinek tz) 
polegający na jego powolnym opadaniu, jak to opisano w par. 2.3.c. 

Zastosowanie w tym przypadku w definicjach technicznych wartości względnych 10% (jak dla 
tranzystora MOSFET – patrz instrukcja 3A, par. 3.3) dla określenia końców przedziałów całkowania 
prowadziłoby do nieobjęcia długich odcinków czasu. 

Tymczasem na obu odcinkach tfu,bip i tz moc chwilowa strat jest znacząca, gdyż zgodnie z rys. 7, 
duże wartości osiąga wówczas odpowiednio prąd iC lub napięcie uCE. Tym istotniejsza byłaby więc 
nieuwzględniona część energii. Dlatego, jak pokazuje rys. 8, zgodnie z normą IEC 607479 końce 
przedziałów całkowania dla energii3 wydzielanej w stanie załączenia Won (chwila tsup(on)) i energii 
wydzielanej w stanie wyłączenia Woff (chwila tsup(off)) należy określać w oparciu o wartość 
względną 2% odpowiednio napięcia uCE lub prądu iC, przy czym 

 
CE(off)

CE
CE(r)

U

u
u =  (2.17) 

Ze względów bezpieczeństwa, w niniejszym ćwiczeniu tranzystor będzie pracować z napięciem 
blokowania UCE(off) dużo niższym od swojej wytrzymałości napięciowej, a jednocześnie z prądem 
bliskim swojej wytrzymałości prądowej. Dlatego napięcie w stanie załączenia UCE(on) może okazać się 
większe niż 2% napięcia w stanie wyłączenia UCE(off), a wówczas określenie chwili tsup(on) nie byłoby 
możliwe. W takim wypadku należy wyznaczyć ją w oparciu wartość względną liczoną nie względem 
zera, a w względem UCE(on), tj. 

                                                      
3 Z powodów podanych w instrukcji 3A, energię oznaczać będziemy konsekwentnie symbolem W zamiast 

symbolu E przewidzianego w normie IEC 60747 dla energii jako parametru katalogowego tranzystorów. 
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Należy mieć świadomość, iż niektórzy producenci stosują własne – odmienne od normatywnych 
– sposoby określania granic przedziałów całkowania. 

Należy też zwrócić uwagę na odmienny (w porównaniu z tranzystorem MOSFET) sposób 
określania początków przedziałów całkowania. Zarówno dla załączania, jak i dla wyłączania, 
norma definiuje go w oparciu o przebieg napięcia sterującego, a nie przebiegi w obwodzie głównym. 
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C 

Doświadczenie 

3. Pomiary 

3.1. Układ doświadczalny 

Schemat układu doświadczalnego jest przedstawiony na rys. 9. Układ umożliwia pomiar napięć 
międzykońcówkowych i prądu kolektora badanego tranzystora IGBT – IRG4BC20S. 

Wartości elementów są następujące: 

� opornik obciążający: R1 = 4,7 Ω, 

� opornik bramkowy: RG = 10 Ω; 150 Ω; 300 Ω; 600 Ω. 

Przełączniki na płycie umożliwiają: 

� K1 – zmianę konfiguracji układu (0 – L – H – P), z których w niniejszym 
ćwiczeniu wykorzystywana jest wyłącznie konfiguracja łącznika dolnego L, 

� K2 – zmianę konfiguracji obciążenia (R – RL – RLD), z których w niniejszym 
ćwiczeniu wykorzystywane jest wyłącznie obciążenie rezystancyjne opornikiem 
R1, 

� K5 – zmianę rezystancji bramkowej RG przez włączenie odpowiedniego 
opornika. 

W celu wyeliminowania wpływu samonagrzewania się badanego tranzystora na jego działanie, 
jak również umożliwienia przepływu dużego prądu bez obawy o cieplne uszkodzenie tranzystora, 
pomiary wykonywane są na pojedynczych impulsach przełączających (załączających, a po 
krótkiej chwili wyłączających) tranzystor. Prostokątny impuls napięcia ug generowany jest przy 
każdorazowym naciśnięciu zielonego przycisku na panelu badanego układu (na rys. 9 – przełącznik 
K4); czas trwania impulsu tp wynosi kilkadziesiąt mikrosekund, a jego amplituda jest w 
przybliżeniu równa napięciu zasilającemu obwód sterujący UGG. Napięcie to, równe 15 V, 
generowane jest wewnątrz układu przez wbudowany zasilacz sieciowy zasilany z sieci 230 V. 

W związku z powyższym po każdej zmianie nastaw konieczne jest wygenerowanie impulsu 
przełączającego. Dotyczy to również sytuacji, gdy nastawy zostały zmienione tylko na urządzeniach 
pomiarowych (oscyloskopie, sondzie prądowej). Dopiero po wygenerowaniu nowego impulsu 
oscyloskop zarejestruje przebiegi przy nowych ustawieniach i zmiana ustawień odniesie 
jakikolwiek skutek. Do tego czasu, nawet jeżeli wydaje się, że przebiegi zostały np. powiększone 
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w poziomie (zmiana podstawy czasu na mniejszą), nie jest to prawdą. W pamięci oscyloskopu nadal 
będą znajdować się dane zarejestrowane przy poprzednich nastawach; jedynie punkty zostaną 
rozstrzelone na osi czasu. Tego typu powiększenie jest podobne do funkcji zoomu cyfrowego – nie 
powoduje ono rejestracji dokładniejszego obrazu, a tylko jego rozciągnięcie. Oscyloskop używany w 
ćwiczeniu sygnalizuje to wyszarzając przebiegi. Powyższe stosuje się również do powiększania w 
pionie (zmiany wzmocnienia napięciowego oscyloskopu lub współczynnika przetwarzania 
wzmacniacza sondy prądowej). 
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Rys. 9. Schemat układu doświadczalnego do badania właściwości dynamicznych standardowego tranzystora 
IGBT (dla przełącznika K1 w pozycji L – łącznik dolny) 

Pomiaru napięć dokonuje się za pomocą sond napięciowych podłączonych w odpowiedni 
sposób do gniazd na panelu układu oznaczonych vE, vG i vC. Do tego celu służą wtyki bananowe z 
wyprowadzeniami umożliwiającymi przyłączenie sondy. 

Pomiaru prądu kolektora dokonuje się przez zamknięcie sondy prądowej wokół 
wyprowadzonego fragmentu przewodu oznaczonego jako iC (jego lokalizację na schemacie układu 
pokazuje strzałka na rys. 9). Strzałka na sondzie wskazuje kierunek przyjmowany za dodatni; sonda 
powinna zostać zaciśnięta w taki sposób, aby był on zgodny ze zwrotem na schemacie. 

Rejestracji danych z oscyloskopu dokonuje się za pomocą programu WaveStar for 
Oscilloscopes dostępnego z menu Start, zakładka Pomiary, w sposób opisany w dalszym ciągu 
niniejszej instrukcji. 
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3.2. Przygotowanie do pomiarów 

Konfiguracja układu pomiarowego 

Schemat blokowy układu pomiarowego przedstawia rys. 10. Jego zestawienia i konfiguracji 
należy dokonać w sposób opisany niżej i w podanej kolejności. 

Aby nie tracić czasu, równolegle z pkt. 1 należy wykonywać kolejne punkty. 

1. Włącz komputer. Po zakończeniu logowania, włącz oscyloskop i skonfiguruj połączenie z 
komputerem postępując ściśle według instrukcji dostępnej na stanowisku. 

2. Upewnij się, że wbudowany zasilacz 15 V układu doświadczalnego jest wyłączony (przełącznik 
K3 w pozycji Off). Włącz wtyczkę sieciową do gniazda sieciowego. 

3. Skonfiguruj połączenia wewnątrz układu doświadczalnego: 

� wybierz topologię łącznika dolnego – przełącznik K1 w pozycji L, 

� wybierz odbiornik rezystancyjny R1 – przełącznik K2 w pozycji R, 

� włącz przewód PB w gniazdo GND.LHP. 

4. Doprowadź zasilanie obwodu mocy: 

a) ze strony internetowej uzyskaj napięcie zasilania obwodu mocy UCC. 

b) użyj zasilacza o 2 sekcjach nastawnych, uprzednio upewniając się, że jest on wyłączony; 
skręć wszystkie pokrętła zasilacza do zera (skrajne położenie przeciwnie do ruchu 
wskazówek zegara); 

c) zasilacz przestaw w tryb szeregowej pracy sekcji – Series (dwa przyciski pośrodku panelu 
czołowego, wyjaśnienie funkcji których znajduje się na panelu nad nimi); 

d) skrajne wyjścia zasilacza (− sekcji Slave, + sekcji Master) połącz z wejściem UCC (nie 
V ZAS H) na płycie układu. 

5. Sondy napięciowe z tłumieniem 10:1 przyłącz do układu w taki sposób, by na kanale 1 mierzyć 
napięcie bramka-emiter uGE, a na kanale 2 – napięcie kolektor-emiter uCE tranzystora. 

Uwaga! 

1. Masy sond napięciowych (końcówki krokodylkowe) są na oscyloskopie zwarte ze sobą i 
połączone z przewodem ochronnym sieci; w związku z tym muszą być zawsze przyłączone 
do tego samego potencjału. Inne połączenie grozi przepływem prądu przez oscyloskop i 
uszkodzeniem jego obwodów wejściowych! 

2. Podczas wykonywania pomiarów nie należy dotykać elementów, na których występuje 
napięcie zasilające obwodu mocy (w szczególności wyprowadzenie potencjału vC). 

3. Przed wykonaniem kolejnego punktu poprawność połączeń musi sprawdzić prowadzący! 

6. Przełącznikiem K3 załącz wbudowany zasilacz obwodu sterowania 15 V. Powinna zapalić się 
dioda sygnalizacyjna obok przełącznika. 

7. Zasil obwód mocy: 

a) załącz zasilacz zewnętrzny; 

b) zwiększ nieco prąd graniczny ograniczenia prądowego (pokrętła Current) obu sekcji, do 
zgaśnięcia czerwonych kontrolek ograniczenia prądowego (C.C.); 

Podczas i po wykonaniu kolejnego podpunktu, przy poprawnej pracy układu amperomierz 
zasilacza nie powinien wykazywać poboru prądu poza stałym prądem diody sygnalizacyjnej 
(ok. 0,02 A) i przejściowym prądem ładowania kondensatora odprzęgającego wewnątrz 
układu (nie więcej niż 0,05 A). Jeżeli podczas nastawiania lub później obserwowane jest co 
innego, należy natychmiast wyłączyć zasilacz i poprosić prowadzącego o ponowne 
sprawdzenie układu. 
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Rys. 10. Schemat blokowy układu pomiarowego 

c) pokrętłem Voltage sekcji Master (w trybie szeregowym powoduje ono jednoczesną regulację 
obu sekcji), ustaw napięcie równe wartości uzyskanej w pkt. 4.a) (ze względu na zasilanie z 
szeregowego połączenia sekcji, wartości tej powinna być równa suma wskazań woltomierzy 
sekcji Slave i Master) – jeżeli w trakcie włączy się ograniczenie prądowe, należy najpierw 
zmniejszyć napięcie, zwiększyć próg ograniczenia prądowego i dopiero wówczas ponownie 
spróbować zwiększyć napięcie. Na płycie układu powinna zapalić się zielona dioda 
sygnalizacyjna. 

8. Za pomocą przycisków Ch1/2/3/4 Menu wyświetl na oscyloskopie przebieg z kanału 1, ukryj ze 
wszystkich pozostałych. 

Każdorazowe wciśnięcie przycisku Menu danego kanału powoduje na przemian wyświetlenie i 
ukrycie odpowiadającego mu przebiegu. Wyświetlanie danego przebiegu sygnalizowane jest przez 
strzałkę wskazującą poziom zera z lewej strony podziałki oraz przez symbol kanału „CHx” pod 
podziałką. 

Pomiar próbny 

9. Na płycie układu doświadczalnego przełącznikiem K5 wybierz rezystor bramkowy o wartości 
RG = 600 Ω. 

10. Skonfiguruj oscyloskop (nie jest do tego potrzebna obecność jakiegokolwiek przebiegu na 
ekranie): 

a) kanał 1 – przycisk Ch1 Menu: 

� sprzężenie ze składową stałą – Coupling: DC, 
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� tłumienie sondy 10:1 – Probe: 10x, 

� odwracanie przebiegu wyłączone – Invert: Off, 

� wzmocnienie dostosowane do przewidywanej amplitudy napięcia uGE – pokrętło Ch1 
Volts/Div (nastawa jest wyświetlana pod podziałką obok symbolu kanału „CH1”); 

b) podstawa czasu: 

� chwila wyzwolenia mniej więcej na środku ekranu – pokrętło Horizontal Position 
(nastawa jest wskazywana przez strzałkę nad podziałką), 

� nastawa podstawy czasu dostosowana do przewidywanego czasu trwania impulsu 
sterującego – pokrętło Sec/Div (nastawa jest wyświetlana pod podziałką po symbolu M); 

c) wyzwalanie – przycisk Trigger Menu: 

� wyzwalanie zboczem – pierwsze pole: Edge, 

� zbocze wyzwalające narastające – Slope: Rising, 

� przebieg wyzwalający uGE – Source: numer odpowiedniego kanału, 

� tryb zwykły – Mode: Normal, 

� sprzężenie z tłumieniem szumu – Coupling: Noise Reject, 

� poziom wyzwalania mniej więcej w połowie przewidywanego przedziału zmienności 
napięcia uGE – pokrętło Trigger Level (nastawa jest wyświetlana pod podziałką po 
symbolu kanału wyzwalającego Ch1 i symbolu zbocza ). 

11. Wygeneruj impuls przełączający tranzystor wciskając zielony przycisk K4 na panelu układu. Na 
oscyloskopie na moment powinien pojawić się komunikat „Trig’d” (triggered – wyzwolony) nad 
podziałką oraz powinien zostać wyświetlony przebieg napięcia uGE. Jeżeli to nie nastąpi, 
sprawdzić poprawność ustawień oscyloskopu (szczególnie wzmocnienie kanału 1 Volts/Div, 
podstawę czasu Sec/Div oraz poziom wyzwalania Level). W przypadku niepowodzenia należy 
poprosić prowadzącego o sprawdzenie ustawień. 

12. Dostosuj (generując impuls przełączający po każdej zmianie ustawień) podstawę czasu i 
położenie chwili wyzwolenia (pokrętła Sec/Div i Horizontal Position) tak, aby impuls napięcia uGE 
był widoczny w całości (por. rys. 7) i zajmował w poziomie większość ekranu. 

13. Przyciskiem Ch2 Menu wyświetl przebieg z kanału 2 – napięcia uCE. Sprawdź: 

� czy ustawienia kanału są zgodne z podanymi w pkt. 10.a) – jeżeli nie, dokonaj 
odpowiednich modyfikacji; 

� czy przebieg nie wykracza poza ekran (pominąć ewentualne krótkie szpilki) lub nie ma 
zbyt niskiej (źle widocznej) amplitudy – w razie potrzeby wyreguluj wzmocnienie i 
położenie poziomu zera (pokrętła Volts/Div i Vertical Position); 

� czy przebieg jest poprawny (patrz rys. 7). 

14. Skonfiguruj wzmacniacz sondy prądowej i jego połączenie z oscyloskopem postępując według 
dostępnej na stanowisku instrukcji do sondy. Obowiązkowo przeczytaj i zastosuj się do 
podanych w instrukcji do sondy wskazówek dotyczących konfiguracji oscyloskopu. W 
odpowiednim momencie: 

� wyjście wzmacniacza przyłącz do kanału 4; 

� ustaw wstępnie współczynnik przetwarzania prąd-napięcie na wartość umożliwiającą 
pomiar i wyświetlenie na oscyloskopie przebiegu o przewidywanej amplitudzie (patrz 
informacje o działaniu wzmacniacza sondy i jego współpracy z oscyloskopem podane w 
instrukcji do sondy; amplitudę należy obliczyć ze znanych parametrów odbiornika i 
zasilania, zakładając idealne zwarcie końcówek głównych tranzystora). 

15. Oprócz nastaw podanych w instrukcji do sondy, ustaw: 

a) na wzmacniaczu sondy: sprzężenie z przenoszeniem składowej stałej – Coupling: DC; 

b) na oscyloskopie (Ch4 Menu): 

� sprzężenie ze składową stałą – Coupling: DC, 

� odwracanie przebiegu wyłączone – Invert: Off. 
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16. Zaciśnij sondę wokół odpowiedniego fragmentu przewodu tak, by mierzyć prąd kolektora iC i 
aby mierzony kierunek tego prądu był zgodny z rzeczywistym. 

17. Generując impuls przełączający, dostosuj: 

� wzmocnienie w torze pomiarowym w sposób opisany w instrukcji do sondy prądowej: 

[A6302/A6312+AM503B] na wzmacniaczu sondy nie na oscyloskopie, 

[TCP312+TCPA300] na kanale 4 oscyloskopu nie na wzmacniaczu sondy, chyba że 
wzmocnienie ustawione na wzmacniaczu nie jest poprawne (co może m.in. objawiać się 
kształtem prądu wyraźnie odbiegającym od impulsu prostokątnego lub zapaleniem 
kontrolki Overcurrent na wzmacniaczu), 

� położenie przebiegu – pokrętłem Vertical Position kanału 4 (na oscyloskopie), 

tak, aby przebieg prądu był widoczny optymalnie, tj. wypełniał ekran w pionie w maksymalnym 
stopniu, ale poza niego nie wykraczał. Skontroluj poprawność przebiegu (patrz rys. 7). 

Jeżeli współczynnik przetwarzania wzmacniacza sondy został znacznie zmieniony (o rząd 
wielkości lub więcej), to należy powtórzyć procedurę kalibracji i rozmagnesowania zamykając 
sondę poza przewodem. 
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3.3. Wykonanie pomiarów 

Pełny cykl przełączania 

1. Wygeneruj impuls przełączający. Upewnij się, że obraz przebiegów jest nadal poprawny. 
Sprawdź, czy amplituda impulsu prądu obserwowana na oscyloskopie jest w przybliżeniu równa 
wartości obliczonej w czasie wykonywania pkt. 3.2/14 (patrz wskazówka dotycząca odczytu 
przelicznika napięcie-prąd w instrukcji do sondy prądowej). 

2. W razie potrzeby dostosuj: 

� wzmocnienie na kanałach napięciowych (1 i 2) – pokrętło Volts/Div, 

� wzmocnienie w torze pomiarowym prądu w sposób opisany w instrukcji do sondy 
prądowej: 

[wzmacniacz AM503B] na wzmacniaczu sondy nie na oscyloskopie, 

[wzmacniacz TCPA300] na kanale 4 oscyloskopu nie na wzmacniaczu sondy, 

� położenie przebiegów – pokrętła Vertical Position, 

tak, aby każdy przebieg, od swojego poziomu zera (wskazywanego przez strzałkę na lewo od 
podziałki) do swojej wartości maksymalnej, zajmował maksymalny obszar całego ekranu w 
pionie, ale poza niego nie wykraczał (nadal zaniedbać ewentualne krótkie szpilki). 

3. [wzmacniacz AM503B] Wykorzystywana sonda prądowa źle przenosi składową stałą przebiegów, 
w wyniku czego może ona niepoprawnie odzwierciedlać poziom zerowego prądu. W związku z 
tym: 

a) należy sprawdzić, czy prąd kolektora widoczny na oscyloskopie znajduje się na poziomie 
zera (wskazywanym przez strzałkę z numerem kanału), gdy tranzystor znajduje się w stanie 
wyłączenia przed załączeniem (zerowe napięcie sterujące uGE); 

b) jeżeli wynik sprawdzenia jest negatywny – należy odpowiednio przesunąć przebieg w 
pionie ręcznie, korzystając z pokrętła Output DC Level na wzmacniaczu sondy prądowej (nie 
z pokrętła Vertical Position na oscyloskopie); 

c) w razie potrzeby poprawić położenie przebiegu prądu na ekranie oscyloskopu odpowiednim 
pokrętłem Vertical Position na oscyloskopie. 

4. Zarejestruj komplet 3 przebiegów uGE, uCE i iC (razem): 

a) w programie WaveStar utwórz nowy arkusz typu YT Sheet; 

b) z panelu bocznego (Local ‣ oznaczenie oscyloskopu ‣ Data ‣ Waveforms ‣ oznaczenie kanału) 
do utworzonego arkusza przeciągnij 3 przebiegi wyświetlane na ekranie oscyloskopu; 

Raz przeciągnięte przebiegi wystarczy później tylko odświeżać wciskając przycisk Refresh Sheet 
lub z menu View, Refresh Datasheet. 

Przebieg można usunąć z arkusza klikając na jego numerze z lewej strony podziałki i wciskając 
klawisz Delete. 

c) arkusz, zawierający wszystkie 3 przebiegi jednocześnie, zapisz w formacie programu 
WaveStar (SHT) – przycisk Save Datasheet (Ctrl+S); 

Nie należy używać funkcji Save Worksheet, która nie powoduje zapisania żadnych danych 
pomiarowych, a jedynie nazw otwartych arkuszy. 

d) zanotuj bieżące ustawienie współczynnika przetwarzania wzmacniacza sondy prądowej 
(patrz sekcja „Przetwarzanie prąd-napięcie” w instrukcji do używanej sondy; jeżeli 
instrukcja ta mówi, że przeliczanie nie jest konieczne, to należy zanotować wartość 1 A/V). 
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Dokładna obserwacja stanu załączania 

5. Zarejestruj przebiegi umożliwiające wyznaczenie czasowych i energetycznych parametrów 
dynamicznych dla załączania tranzystora (nie dla jakiegokolwiek innego stanu pracy): 

a) ustaw podstawę czasu (Sec/Div), położenie momentu wyzwalania (Horizontal Position) oraz 
ewentualnie poziom wyzwalania (Level) tak, aby z maksymalną dokładnością obserwować 
przebieg załączania tranzystora (nie jakiegokolwiek innego stanu pracy) w obwodzie 
głównym, tj. na odcinku ton (zob. rys. 7); 

b) jeżeli wskutek niedoskonałego działania sondy prądowej, widoczna na oscyloskopie wartość 
prądu w stanie wyłączenia – o której wiadomo, iż w bieżącej skali jest niezauważalnie mała 
– nie jest zlokalizowana dokładnie na poziomie zera odpowiedniego kanału oscyloskopu 
(wskazywanym przez strzałkę na lewo od podziałki), odpowiednio przesuń przebieg prądu 
na wzmacniaczu sondy, tak aby wartość ta znalazła się dokładnie na tym poziomie: 

� [wzmacniacz AM503B] pokrętłem Output DC Level, 

� [wzmacniacz TCPA300] przyciskami Manual Balance �/� (ze względu na dużą amplitudę 
prądu, przycisk należy przytrzymać przez kilkanaście sekund, by przesunięcie przebiegu 
stało się zauważalne); 

Niewykonanie powyższego podpunktu spowoduje, iż wyniki będą błędne i nie będą 
nadawały się do opracowania. 

c) upewnij się, że na ekranie widoczne są wszystkie chwile przekroczenia wszystkich 
potrzebnych progów pozwalające na wyznaczenie wszystkich parametrów czasowych stanu 
załączania (patrz rys. 8) – w przeciwnym razie dostosuj podstawę czasu (Sec/Div), położenie 
momentu wyzwalania (Horizontal Position) oraz ewentualnie poziom wyzwalania (Level); 

d) upewnij się, że ustawienia kanałów nadal spełniają wymagania podane w pkt. 2, jednak 
obecnie z uwzględnieniem ewentualnych przepięć – w przeciwnym razie zmień je zgodnie z 
pkt. 2; 

e) w programie WaveStar utwórz 2 nowe arkusze – typu YT Sheet i typu Power Harmonics; 

Arkusz Power Harmonics umożliwia między innymi wymnożenie dwóch przebiegów przez siebie. 
Jeżeli przebiegami tymi będą prąd i płynący między węzłami obwodu oraz napięcie u między tymi 
węzłami, uzyskany iloczyn i∙u z definicji będzie mocą chwilową p wydzielaną w elementach 
znajdujących się między tymi węzłami. 

f) użyj arkusza Power Harmonics do obliczenia przebiegu chwilowej mocy strat pC: 

� do okienka Current Waveform na dole arkusza Power Harmonics przeciągnij przebieg 
prądu iC z panelu bocznego; 

� do okienka Voltage Waveform przeciągnij przebieg napięcia odpowiedniego do 
uzyskania mocy strat w obwodzie kolektora tranzystora pC (nie jakiegokolwiek innego 
iloczynu przebiegów); 

Kolejny podpunkt należy najpierw przeczytać w całości łącznie z uwagami poniżej, a 
dopiero później przystąpić do jego wykonywania. 

g) do arkusza YT Sheet przeciągnij komplet 4 przebiegów uGE, uCE, iC, pC; 

Aby nie tracić czasu na ponowne pobieranie z oscyloskopu (czynność ta będzie jeszcze 
kilkakrotnie powtarzana), wszystkie 3 przebiegi wyświetlane już w arkuszu Power 
Harmonics należy przeciągnąć z tego arkusza, nie z panelu bocznego. Jedynie przebieg 
brakujący trzeba przeciągnąć z panelu bocznego. 

Przez ukończeniem wszystkich pomiarów opisanych w niniejszej instrukcji, w programie 
WaveStar nie należy zmieniać żadnych parametrów przebiegów. Jedyne wyjątki to: 

� zmiana koloru z paska narzędzi na górze okna arkusza; 

� przesunięcie poziomu zera za pomocą strzałki z lewej strony podziałki; 
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� przesunięcie chwili wyzwolenia opisane w podpunkcie h). 

Wszelkie inne zmiany spowodują niemożność skorzystania z funkcji odświeżania arkuszy, co 
znacząco wydłuży czas wykonywania ćwiczenia. 

h) z reguły konieczna jest synchronizacja przebiegu mocy z pozostałymi – w tym celu należy 
zaznaczyć przebieg mocy klikając na numerze przebiegu z lewej strony podziałki, a 
następnie kolorowy suwak nad podziałką umieścić dokładnie między białymi znacznikami w 
formie nawiasów kwadratowych; 

i) zapisz arkusz YT Sheet zawierający komplet 4 przebiegów oraz zanotuj bieżące ustawienie 
wzmocnienia sondy prądowej (jeżeli uległo zmianie). 

6. Zmień rezystancję bramkową RG na 300 Ω. 

7. Uzyskaj i zarejestruj przebiegi w nowych warunkach: 

a) wygeneruj impuls przełączający; 

b) upewnij się, że na ekranie widoczne są wszystkie chwile przekroczenia wszystkich 
potrzebnych progów pozwalające na wyznaczenie wszystkich parametrów czasowych stanu 
załączania – w przeciwnym razie dostosuj podstawę czasu (Sec/Div), położenie momentu 
wyzwalania (Horizontal Position) oraz ewentualnie poziom wyzwalania (Level); 

c) jeżeli wskutek niedoskonałego działania sondy prądowej, widoczna na oscyloskopie wartość 
prądu w stanie wyłączenia – o której wiadomo, iż w bieżącej skali jest niezauważalnie mała 
– nie jest zlokalizowana dokładnie na poziomie zera odpowiedniego kanału oscyloskopu 
(wskazywanym przez strzałkę na lewo od podziałki), odpowiednio przesuń przebieg prądu 
na wzmacniaczu sondy, tak aby wartość ta znalazła się dokładnie na tym poziomie: 

� [wzmacniacz AM503B] pokrętłem Output DC Level, 

� [wzmacniacz TCPA300] przyciskami Manual Balance �/� (ze względu na dużą amplitudę 
prądu, przycisk należy przytrzymać przez kilkanaście sekund, by przesunięcie przebiegu 
stało się zauważalne); 

Niewykonanie powyższego podpunktu spowoduje, iż wyniki będą błędne i nie będą 
nadawały się do opracowania. 

d) upewnij się, że ustawienia kanałów nadal spełniają wymagania podane w pkt. 2, jednak 
obecnie z uwzględnieniem ewentualnych przepięć – w przeciwnym razie zmień je zgodnie z 
pkt. 2; 

e) najpierw odśwież arkusz Power Harmonics (uaktywnij ten arkusz i wciśnij przycisk Refresh 
Sheet lub wybierz z menu View ‣ Refresh Datasheet, nie Refresh Workbook), 

f) następnie analogicznie odśwież arkusz YT Sheet. 

g) zsynchronizuj przebieg mocy z pozostałymi; 

h) zapisz arkusz YT Sheet zawierający komplet 4 przebiegów oraz zanotuj bieżące ustawienie 
wzmocnienia sondy prądowej (jeżeli uległo zmianie). 

Dokładna obserwacja stanu wyłączania 

8. Zarejestruj przebiegi umożliwiające wyznaczenie czasowych i energetycznych parametrów 
dynamicznych dla wyłączania tranzystora: 

a) przed wykonaniem jakichkolwiek innych czynności przełącz się na wyzwalanie zboczem 
opadającym napięcia uGE – Trigger Menu, Slope: Falling; 

Niewykonanie powyższego podpunktu znacząco wydłuży wykonanie ćwiczenia, między 
innymi przez utrudnienie uzyskania obrazu przebiegu mocy chwilowej w aplikacji na 
komputerze. 

b) powtórz pkt 7 w całości, tzn wszystkie jego podpunkty (a nie tylko niektóre), z tym że 
oceniając poprawność obserwowanych przebiegów, zamiast załączania należy oczywiście 



36 ◆ C 3 Przyrządy i układy mocy – Ćwiczenie 4A. Tranzystory IGBT (5.8.1) 

© 2017 Łukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki Łódzkiej 

rozważać wyłączanie na odcinku toff rozumianym fizycznie (tzn. nie według definicji 
technicznych, lecz zgodnie z rys. 7). 

Powyższy podpunkt nie mówi, że na ekranie ma być widoczny dowolny fragment 
odcinka toff, tylko odcinek toff, co oznacza cały ten odcinek. Niepoprawne wykonanie 
tego podpunktu spowoduje, że niemożliwe będzie uzyskanie niezbędnych wyników. W 
razie wątpliwości należy jeszcze raz przestudiować wskazany wyżej rysunek uwzględniając 
wszystkie 3 przebiegi widoczne na oscyloskopie i skonsultować wynik z prowadzącym. 

[A6302/A6312+AM503B] szczególną uwagę należy zwrócić na wykonanie ppkt. 7.c), 
uwzględniając występowanie ogona prądowego; 

Niewykonanie powyższego podpunktu spowoduje, iż wyniki będą błędne i nie będą 
nadawały się do opracowania. Uzyskany na oscyloskopie obraz należy skonsultować z 
prowadzącym. 

9. Zmień rezystancję bramkową RG na 600 Ω. 

10. Powtórz pkt 7 w całości, tzn wszystkie jego podpunkty (a nie tylko niektóre), nadal rozważając 
wyłączanie zamiast załączania. 

Zakończenie pomiarów 

11. [wzmacniacz AM503B] Na wzmacniaczu sondy prądowej sprowadź nastawę pokrętła Output DC 
Level do wartości 0,0 – jeżeli była modyfikowana (jest ona wyświetlana w polu Current/Division 
podczas nastawiania). 

12. Sprowadź do zera napięcie zasilacza zewnętrznego (pokrętło Voltage sekcji Master). Zaczekaj na 
zgaśnięcie zielonej diody sygnalizacyjnej na płycie układu. Wyłącz zasilacz. 

13. Wyłącz wbudowany zasilacz obwodu sterowania 15 V. Wyjmij wtyczkę z gniazda sieciowego. 

14. Rozłącz układ; nie odłączaj jednak: sond napięciowych od oscyloskopu, sondy prądowej od jej 
wzmacniacza, a wzmacniacza sondy od oscyloskopu. 
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D 

Wyniki 

4. Opracowanie i analiza wyników 

4.1. Parametry stanów statycznych 

1. Uruchom program WaveStar. 

2. Otwórz zestaw przebiegów {uGE; uCE; iC} dla pełnego impulsu napięcia sterującego – 
zarejestrowany w pkt. 3.3/4. 

3. Na podstawie zanotowanej w pkt. 3.3/4 nastawy współczynnika przetwarzania prąd-napięcie 
wzmacniacza sondy prądowej, wyznacz mnożnik ki w amperach na wolt – przez który należy 
przemnożyć wykazywaną w programie WaveStar wartość w woltach, aby uzyskać rzeczywistą 
wartość prądu w amperach. 

Wartości wykazywane w programie WaveStar dla przebiegów prądu są de facto zarejestrowanymi 
przez oscyloskop wartościami napięcia pochodzącego ze wzmacniacza sondy prądowej. Będziemy je 
oznaczać gwiazdką. Napięcie to jest proporcjonalne do prądu zgodnie z zanotowanym 
współczynnikiem przetwarzania wzmacniacza sondy prądowej. Mnożnik, wynikający bezpośrednio z 
tego współczynnika, ale ze względów praktycznych wyrażony w jednostkach pierwotnych SI, tj. A/V, 
pozwoli otrzymać rzeczywiste wartości w amperach: i = ui ∙ ki, gdzie ui jest wartością napięcia 
wykazywaną na przebiegu prądu na oscylogramie. Przykładowo, jeżeli współczynnik wzmocnienia 
sondy wynosił 5 A / 10 mV, to ki = 5 A / 10 mV = 500 A/V. 

Zgodnie z instrukcją do sondy ze wzmacniaczem A6302/A6312+AM503B, wartość podawana na 
wyświetlaczu miała jednostkę A/10 mV lub mA/10 mV. W przypadku wzmacniacza TCPA300, pod 
warunkiem konfiguracji oscyloskopu zgodnie z instrukcją, spodziewany jest współczynnik 1 A/V 
[patrz pkt 3.3/4.d)]. 

4. Wypełnij część 1 sprawozdania. 

Do wykonania poleceń konieczne będzie wykorzystanie w programie WaveStar kursorów zgodnie z 
poniższymi wskazówkami. 

1. Aby włączyć kursory, należy wybrać z menu View ‣ Properties ‣ Cursor i wybrać typ kursora 
odpowiedni dla wykonywanego pomiaru (poziomy – horizontal, pionowy – vertical, sprzężony – 
paired, punktowy – crosshair). W aktywnym arkuszu YT Sheet pojawią się wartości 
odpowiadające aktywnemu przebiegowi, w zależności od rodzaju kursora: 
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— X, Y – współrzędne aktywnego (linia ciągła) kursora; 

— X1, Y1 i X2, Y2 – współrzędne pierwszego i drugiego kursora; 

— dX, dY – różnica współrzędnych drugiego i pierwszego kursora. 

2. Aktywny przebieg wybierany jest przez kliknięcie na jego numerze z lewej strony podziałki. 
Numer aktywnego przebiegu jest stale podświetlony. Numery nakładają się, jeżeli poziomy zera 
kilku przebiegów znajdują się na tej samej wysokości; w takim wypadku, aby móc zaznaczyć 
przebieg znajdujący się pod spodem, przebieg wierzchni należy najpierw przesunąć. 

3. W rozróżnieniu poszczególnych przebiegów pomoże włączenie kolorowania legendy: menu View 
‣ Properties ‣ Plot, zaznaczyć Waveform notes color match waveform color. 

4. Po przełączeniu na inny przebieg, kursor poziomy pozostaje na tej samej wysokości w woltach 
(nie działkach). Oznacza to, że przy dużej różnicy skali (V/div) kursor może znaleźć się poza 
ekranem. W takiej sytuacji, przed przełączeniem się na drugi przebieg, kursor należy ustawić w 
pobliżu zera. 

Przykład odczytu wartości prądu kolektora w stanie załączenia IC(on) pokazuje rys. 11. 

 
Rys. 11. Przykład odczytu wartości prądu (przed przeliczeniem na ampery) w stanie przewodzenia 
U(IC(on)) = 64,2 mV (wskazanie Y) z pominięciem wpływu zwisu 

 



Opracowanie i analiza wyników D 4 ◆ 39 

© 2017 Łukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki Łódzkiej 

4.2. Parametry dynamiczne 

Uruchomienie programu Scilab 

1. Uruchomić pakiet do obliczeń numerycznych Scilab. 

2. Aby w dalszym ciągu pracy nie wpisywać za każdym razem pełnej ścieżki dostępu do plików z 
danymi pomiarowymi (pliki programu WaveStar), można zmienić katalog roboczy na katalog 
zawierający te pliki, wpisując polecenie 

cd('ścieżka_dostępu_do_pomiarów'); 

3. Wczytaj skrypt zawierający funkcje potrzebne do obliczenia energii wydzielanej w tranzystorze, 
wpisując polecenie (w razie potrzeby należy dodać ścieżkę dostępu do pliku) 

exec('wavestar_calka.sce'); 

Parametry czasowe 

4. Na podstawie odczytanych dotychczas i zamieszczonych w sprawozdaniu odpowiednich 
wartości napięć i prądu w stanach statycznych, oblicz wartości bezwzględne – tj. w woltach lub 
amperach, a nie w procentach – odpowiadające poszczególnym wartościom procentowym 
występującym w technicznych definicjach parametrów czasowych i energetycznych zgodnie z 
normą IEC 607479. Ze względu na wartość napięcia kolektor-emiter w stanie wyłączenia UCE(off) 
znacznie mniejszą od napięcia znamionowego tranzystora (600 V), stosunek UCE(on)/UCE(off) jest 
porównywalny lub większy niż 2%; należy wobec tego zastosować zmodyfikowaną definicję 
wartości względnej uCE*. 

5. W programie WaveStar otwórz zestaw przebiegów {uGE; uCE; iC; pC} dla procesu załączania, dla 
RG = 600 Ω – zarejestrowany w pkt. 3.3/5. 

6. Wyznacz parametry czasowe stanu załączania: 

a) za pomocą kursorów sprzężonych, odczytaj wartość czasu opóźnienia załączania td(on) 
zgodnie z normatywną definicją techniczną (patrz par. 2.5.a), w oparciu o wartości obliczone 
w pkt. 4 (zob. rys. 12); 

Przykłady odczytu wartości podane na rysunkach w tym podrozdziale pokazują jedynie sposób 
postępowania. Nie sugerują one poprawnych wartości ani wyglądu przebiegów w arkuszu. W 
celu zwiększenia czytelności, przykładowe oscylogramy zawierają wyłącznie przebiegi niezbędne 
do wykonania konkretnego podpunktu. 

b) analogicznie odczytaj wartość czasu narastania tr. 

Parametry energetyczne 

7. Na podstawie zanotowanej nastawy współczynnika przetwarzania prąd-napięcie wzmacniacza 
sondy prądowej, wyznacz mnożnik ki dla obecnie przetwarzanego oscylogramu (jeżeli nastawa 
wzmacniacza nie była zmieniana, nie jest to konieczne – wartość obliczona w pkt. 4.1/3 
pozostaje ważna). 

Wartości mocy chwilowej powstały przez wymnożenie napięć rejestrowanych na odpowiednich 
kanałach oscyloskopu. Jedno z nich było równe rzeczywistemu napięciu u, a drugie ui było 
proporcjonalne do prądu i zgodnie ze współczynnikiem ki (patrz pkt 4.1/3). Przebieg mocy 
wykazywany jest więc na oscylogramie w jednostce V∙V, jako iloczyn yp = u ∙ ui. Aby uzyskać wartość 
mocy w watach, należy przemnożyć odczyt yp przez współczynnik ki, gdyż p = u i = u (ui ki) = (u ui) kí 
= yp ki. Ponieważ energia jest całką z mocy, ten sam mnożnik należy zastosować dla uzyskania 
wartości energii w dżulach. 
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8. Z programu WaveStar uzyskaj dane niezbędne do obliczenia energii wydzielanej podczas 
załączania: 

a) za pomocą kursorów odczytaj współrzędne granic całkowania tinf(on) i tsup(on) zgodnie z 
wymaganiami normy w odniesieniu do energii wydzielanej podczas załączania WC(on) (patrz 
par. 2.5.b oraz rys. 13); 

b) wyeksportuj dane do pliku tekstowego typu CSV (comma-separated values), wybierając z 
menu File ‣ Export Datasheet ‣ CSV. 

9. W programie Scilab oblicz energię wydzielaną podczas załączania WC(on): 

a) odczytaj wyeksportowane dane poleceniem 

[naglowek,dane]=wczytaj_ws('nazwa_pliku.csv'); 

Przy obliczeniach dla kolejnych przypadków można przywołać wcześniej wpisane polecenie 
klawiszem ↑. 

b) oblicz energię WC(on) jako całkę przebiegu pC za przedział od tinf(on) do tsup(on) [wzór (2.15)], z 
uwzględnieniem mnożnika ki, wydając polecenie 

calka_infsup(dane,numer_przebiegu_pc,tinf,tsup,ki) 

Parametr numer_przebiegu to numer kolejny przebiegu pC zgodnie z rosnącą numeracją w 
programie WaveStar (nie numer kanału oscyloskopu). Np. jeżeli w programie WaveStar 
wyświetlane są: 2) uCE, 3) iC, 4) pC, 6) uGE, to przebieg pC jest trzecim z kolei, należy więc podać 
numer_przebiegu = 3; jeżeli zaś numeracja zaczyna się od 1 i nie ma przerw, to numer_przebiegu 
jest identyczny jak w programie WaveStar. 

Można również wykorzystać alternatywną postać funkcji całkującej, calka_infint(). Działa ona 
identycznie jak poprzednia, jedynie zamiast górnej granicy całkowania tsup przyjmuje za 
parametr czas całkowania tint. Jest to o tyle wygodniejsze, że z okna YT Sheet można za jednym 
razem przepisać oba parametry czasowe (X i dX). 

Przy założeniu, że kolejność wyświetlania przebiegów była następująca: 1) uCE, 2) iC, 3) pC, 4) uGE, 
ki = 100 A/V zaś pozostałe parametry mają wartości jak na przykładowym rysunku 13 (zob. 
podpis do rysunku), należy wprowadzić polecenie: 

calka_infsup(dane,3,-0.12E-6,1.60E-6,100) 

lub 

calka_infint(dane,3,-0.12E-6,1.72E-6,100) 

lub 

calka_infint(dane,3,1.60E-6,-1.72E-6,100) 

c) powyższa funkcja zwróci wartość całki w dżulach i kontrolnie wykreśli przebieg pC 
przeskalowany przez ki oraz zaznaczy obszar, którego polu odpowiada obliczona całka; 

na podstawie tego wykresu kontrolnego sprawdź, czy całka została obliczona za właściwy 
fragment przebiegu mocy (por. rys. 8 i 14), a jeżeli nie – poprawnie wyznacz granice 
przedziału całkowania i wyznacz energię ponownie; 

d) zapisz wykres kontrolny poleceniem Plik ‣ Eksportuj do (zaleca się format PNG). 

Dalsze przypadki 

10. Powtórz punkty 5–9 dla przypadku RG = 300 Ω – w oparciu o zestaw przebiegów zarejestrowany 
w pkt. 3.3/7. 

11. Wyznacz parametry stanu wyłączania dla przypadku RG = 600 Ω – w oparciu o zestaw 
przebiegów zarejestrowany w pkt. 3.3/10: 

a) powtórz punkty 5–9 dla stanu wyłączania w celu wyznaczenia odpowiednio parametrów 
czasowych td(off) i tf oraz energetycznego WC(off); 
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Ze względu na znaczne zaszumienie przebiegu iC, określając chwilę tsup(off) należy rozpatrywać 
przekroczenie poziomu 2% IC(on) przez środek tego przebiegu, a nie przypadkowe pierwsze 
przekroczenie przez jego dolne ekstremum lokalne wynikające z obecności szumu. 

b) w programie WaveStar, obejmij kursorami fizyczny czas ogona prądowego tz: 

� kursor końcowy pozostaw w chwili tsup(off) (lub przesuń go odpowiednio, jeżeli nie 
wskazuje tej chwili), 

� kursor początkowy przesuń do początku ogona prądowego, tj. do chwili t7 według rys. 7 
(punkt zmiany stromości opadania prądu iC, nie koniec odcinka tf na rys. 8); 

c) w programie Scilab oblicz składową energii związaną z ogonem prądowym WC(off,z) (por. rys. 
8) jako całkę za przedział czasu od t7 do tsup(off), czyli za przedział tz określony w ppkt. b); 
zapisz wykres kontrolny. 

12. Powtórz pkt 11 dla RG = 300 Ω – w oparciu o zestaw przebiegów zarejestrowany w pkt. 3.3/8, 
przy czym w tym przypadku w toku wykonywania zanotuj: 

� długość przedziału całkowania tint(off) dla energii WC(off) (por. rys. 8), 

� czas ogona prądowego tz. 

Podsumowanie wyników 

1. W odpowiednich miejscach w części 2 sprawozdania zamieść wykorzystane oscylogramy dla 
drugiej z wartości RG oraz wykresy kontrolne otrzymane podczas obliczeń parametrów 
energetycznych. 

2. Wyznaczone do tej pory parametry czasowe i energetyczne zamieść w tabelach w części 5 
sprawozdania. Aby umożliwić analizę wyników, wszystkie czasy dla wszystkich przypadków 
muszą być podane w tej samej jednostce; analogicznie wszystkie wartości mocy i wszystkie 
wartości energii (włącznie z tymi, które zostaną obliczone w dalszym ciągu). 

3. Oblicz (zob. podrozdz. 2.5) i dodaj do odpowiednich tabel czas załączania ton i czas wyłączania 
toff. 

4. Oblicz i zamieść w ostatnim wierszu tabel iloraz zmiany (ile razy zmieniają się – nie o jaką 
wartość zmieniają się) każdego z parametrów (ze wszystkich kolumn, w tym RG) wraz ze zmianą 
rezystancji z mniejszej na większą (nie odwrotnie – tak, aby uzyskać w większości przypadków 
liczby większe od 1), tj. 

 
)(

)(
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RX
Xq =  (4.1) 

gdzie X oznacza dany parametr tranzystora, zaś RGH i RGL – odpowiednio większą i mniejszą z 
wartości rezystancji RG. 

5. Uzupełnij część 2 sprawozdania. 

Analiza parametrów czasowych 

6. Uzyskaj wykres, na podstawie którego będzie możliwe porównanie ogona prądowego dla 
różnych rezystancji bramkowych: 

Liczbowe porównanie parametrów ogona prądowego byłoby mało wiarygodne ze względu na dużą 
niepewność określania chwili tsup(off). Dlatego też oprzemy się na analizie graficznej. 

a) w programie WaveStar, z arkusza YT Sheet dla wyłączania przy RG = 300 Ω usuń wszystkie 
przebiegi oprócz prądu iC; 

b) do arkusza z ppkt. a) przeciągnij myszą przebieg prądu iC z arkusza YT Sheet dla wyłączania 
przy RG = 600 Ω; 
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c) jeżeli skale czasu (wykazywane w legendzie wykresu) poszczególnych przebiegów są różne, 
dokonaj ich ujednolicenia korzystając z listy rozwijanej w pasku narzędzi okna arkusza YT 
Sheet, lub z menu View ‣ Properties ‣ zakładka odpowiedniego przebiegu ‣ Horizontal Scale; 

d) za pomocą suwaka nad podziałką, zsynchronizuj przebiegi ze sobą względem początku 
ogona prądowego (tj. przesunąć w poziomie tak, aby początki ogonów prądowych pokryły 
się); 

e) poziomy zera (tj. poziomy prądu w stanie wyłączenia) obu przebiegów ustaw na tym samym 
poziomie – przesuwając je za numer przebiegu z lewej strony podziałki, lub z menu View ‣ 
Properties ‣ zakładka odpowiedniego przebiegu ‣ Vertical Position; 

f) uzyskany arkusz zapisz pod nową nazwą. 

7. Wypełnij część 3 sprawozdania. 

Analiza parametrów energetycznych 

8. Wypełnij część 4 sprawozdania. 

Porównanie tranzystorów IGBT i MOSFET 

9. Wypełnij część 5 sprawozdania. 

 
Rys. 12. Przykład odczytu czasu td(on) = 256 ns (wskazanie dX); wskazanie Y pokazuje, że prawy kursor został 
ustawiony w pierwszym punkcie, w którym wartość iC przekracza 10% IC(on)* (patrz rys. 11) 
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Rys. 13. Przykład odczytu wartości tsup(on) = 1,60 µs z przebiegu uCE (w tym przypadku wartości względnej 
uCE(r)* = 2% odpowiada wartość bezwzględna 5,23 V); drugi kursor (na przebiegu uGE) wskazuje chwilę 
tinf(on) = −0,12 µs. Długość przedziału całkowania (wskazanie dX) wynosi więc tint(on) = 1,72 µs 

 
Rys. 14. Wykres kontrolny z programu Scilab przy poprawnym wyznaczeniu energii wydzielanej podczas 
załączania 
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E 

Informacje 

5. Wymagana wiedza 

5.1. Przygotowanie do wykonywania ćwiczenia 

� Przebiegi napięć i prądów podczas przełączania tranzystora IGBT 
(zob. par. 2.3) 

� Definicje fizyczne i techniczne dynamicznych parametrów czasowych i 
energetycznych tranzystora MOSFET 
(zob. par. 2.3 i 2.5) 

5.2. Zakres kolokwium 

1. Tranzystor IGBT: symbol, przekrój komórki NPT-N-IGBT, końcówki, obwód 
sterowania i obwód główny. Dwuelementowe schematy zastępcze i lokalizacja ich 
elementów na przekroju struktury półprzewodnikowej. 
(zob. par. 2.1) 

2. Statyczna charakterystyka wyjściowa tranzystora IGBT; zakresy pracy i ich 
wykorzystanie w układach o działaniu przełączającym. Działanie tranzystora w 
stanie przewodzenia: ścieżki przepływu nośników wewnątrz struktury 
półprzewodnikowej, miejsce tworzenia kanału i obszar gromadzenia nośników 
nadmiarowych. Wpływ mechanizmów przewodnictwa na spadek potencjału na 
strukturze (z odwołaniem do schematów zastępczych); prąd główny (IC) w zależności 
od prądu kanału MOS (wzór). Pozytywny skutek wprowadzenia (względem 
tranzystora MOSFET) nośników mniejszościowych do bazy N. 
(zob. par. 2.2) 

3. Przebiegi napięć i prądu oraz mocy chwilowej strat (w obwodzie głównym) podczas 
przełączania tranzystora IGBT z obciążeniem rezystancyjnym. Wyłączanie części 
MOS i części bipolarnej struktury; ogon prądowy i jego geneza fizyczna. Energia 
wydzielana podczas wyłączania, związek z mocą chwilową, związek z ogonem 
prądowym (wzór). Negatywny skutek wprowadzenia (względem tranzystora 
MOSFET) nośników mniejszościowych do bazy – niekorzystne konsekwencje ogona 
prądowego dla parametrów czasowych i energetycznych tranzystora. 
(zob. par. 2.3, sprawozdanie) 

4. Wpływ rezystancji bramkowej na poszczególne czasowe i energetyczne parametry 
dynamiczne tranzystora oraz na parametry ogona prądowego (amplituda, czas 
zaniku, energia). Związek z fizycznymi podstawami działania tranzystora IGBT. 
(zob. par. 2.3, sprawozdanie) 



46 ◆ E 6 Przyrządy i układy mocy – Ćwiczenie 4A. Tranzystory IGBT (5.8.1) 

© 2017 Łukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki Łódzkiej 

6. Literatura 

[1] Napieralski A., Napieralska M.: Polowe półprzewodnikowe przyrządy dużej mocy. Warszawa: 
Wydawnictwa Naukowo-Techniczne, 1995. 

[2] Khanna V. K.: IGBT theory and design. Piscataway: IEEE Press, John Wiley & Sons, 2003. 


